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Introduction

The Hitachi Serial Communications Operator
Interface, SC-OPE 3H, is an easy-to-use
inverter operator panel. Its 4-line dot matrix
display shows inverter status and works in
conjunction with its keypad to provide inverter
control and parameter editing capability.

The SC-OPE 3H has various mounting
options:

-

+ Directly on the inverter (SJ300 / L300P)

* Panel-mounting with bezel/housing
* DIN-rail mounting inside panel

The SC-OPE 3H (“H” connotes HVAC version) provides a built-in network inter-
face for connecting an inverter to popular building/factory networks, including:

¢ DirectNet Host computer (PC) Inverters with SC-OPE 3H

* Allen-Bradley DF1

* Modbus ASCII

* Modbus RTU

* Metasys N2

This manual includes

specific examples for
ModBus RTU and
DirectNet connec-
tions with Direct-
Logic PLCs. See
“Using Networks for
Inverter Operation”

on page 4-1. Building or Factory Network

Host computer (PLC)

cCUoTo
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m Note: The SC-OPE 3H network interface limits the J300 inverter to connecting to
the Metasys N2 network only.
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Conventions in  Paragraphs with special meanings are accompanied with a symbol in the margin.
this Manual These include:

Note: A Note calls attention to a detail that you may need to know to use the product g
feature being discussed. §

@

3
Tip: A Tip suggests a way to apply the product that you may find helpful in your o

S application.
A Caution: A Caution message informs you of the potential of a minor hazard or an

inconvenience in applying the product.

A Warning: A Warning message informs you of the potential of bodily injury or
equipment damage.
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Keypad Orientation
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Monitor Mode displays important inverter data such as motor current in
amperes or percent, torque in percent, and output frequency. You can
program which monitor values are displayed. The Run command
source and frequency setting source are also displayed. When the
sources for Run command and Frequency Setting are set to be the
SC-OPE keypad, you can use Monitor Mode to change the motor speed
and run the motor.

The Quick Menu displays a short list of frequently used parameters.
You can configure a SC-OPE to display the particular subset of param-
eters most often referenced or changed in your application.

Program Mode provides access to edit the inverter’s parameters. The
parameters are organized into categories to provide a tree-like structure
to access and edit parameter values.

The Change Data function allows you to change the value of the
inverter parameter currently displayed on the SC-OPE.

The Mode key allows navigation between the SC-OPE’s normal modes
or functions and Configuration Mode, used to configure the SC-OPE.
Configuration Mode includes a data transfer utility that is used in com-
munications with a PC. A configuration file stores the SC-OPE’s
network port settings, inverter family type, and other data.

The Read/Write Menu key accesses separate Read EEPROM Data or
Write EEPROM Data operations, which move SC-OPE parameter set-
tings to/from the inverter’s EEPROM.

After a Change Data operation, use the Store/Enter key to store the new
value to the inverter’s RAM. Pressing the Store/Enter key is required
when you want to enter certain operational modes or sub-menu topics
(denoted by the [Enter] prompt on the SC-OPE display).

The Esc/Cancel key provides a way to exit a menu item or cancel a
pending data change operation.
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A

LED Indicators

The Help screen displays user-configurable text such as contact infor-
HELP mation for technical help or application assistance.

The Start/Run key sends the Run Fwd command to the inverter to run
the motor. The inverter must be configured to use the keypad as the
Run command source, quickly done by using the Hand/Auto key.
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The Stop/Reset key will cause the inverter to stop the motor if it is run-
ning. When a trip condition exists, the Reset function will clear the trip
condition for normal inverter operation (if the cause of the trip has been
eliminated).

The Hand/Auto key provides a way to quickly change the Run
HAND | command source (terminal strip or SC-OPE keypad), and to change the
Frequency Setting source (terminal, potentiometer input, or keypad).

G The Arrow keys provide a way to select menu functions or move the
<] [:> display cursor while editing parameters.

Warning: The Stop/Reset key on the SC-OPE is not a substitute for an Emergency
Stop push button. Always include a mechanical Emergency Stop switch within easy
reach of an operator in your application.

The Power LED is ON whenever the SC-OPE has power. The inverter
directly powers the SC-OPE in most applications, so the LED also indicates
the presence of inverter input power.

The RUN LED is ON whenever a Run command is active (the actual output
frequency > 0 and the motor is turning in either direction).

The Fault LED is ON whenever the inverter has recorded a trip event that
has not been cleared.
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Specifications

The SC-OPE 3H product features are outlined in the following table.

Item

Description

Inverter compatibility

Hitachi SJ100, L100, SJ300, L300P, J300

Display

LCD dot matrix, 20-character x 4-line display

Keypad

Membrane keys

Key functions

Monitor, Quick Menu, Program Mode, Change Data,
Mode Change, Read/Write, Store/Enter, Esc/Cancel,
Help Screen, Start/Run, Stop/Reset, Hand/Auto, Right
Arrow, Left Arrow, Up Arrow, Down Arrow

LED indicators

Power LED, Run LED, Fault LED

Firmware

L100 / SJ100 families, or SJ300 / L30OP families (down-
load either firmware type)

Front connector

Modular RJ11, RS-232

Rear connector

Modular RJ45, SC-OPE-to-inverter connection only

Bottom connector

10-pin connector, RS—422 / RS—-485 differential / external
+5V power

Mounting options

1)Directly on inverter housing (SJ300 or L300P only)
2) Panel mount (use bezel kit); connect to inverter via
cable

3) DIN rail mounting

Power consumption

+5V +/- 5% regulated, 200 mA maximum

Dimensions, mm (in.)

W = 112 (4.41), H = 131(5.16), D =40 (1.58)

Bezel dimensions, mm (in.)

W = 161 (6.34), H = 187 (7.4), D = 38 (1.50)

Bezel mounting hole center
locations, mm (in.)

Horizontal = 137 (5.39), Vertical = 135 (5.32)

Network port protocols *1

DirectNet, Allen-Bradley DF1, ModBus RTU, ModBus
ASCII, MetasysN2

Network baud rates

300, 600, 1200, 2400, 4800, 9600, 19200

Network mode (electrical)

RS-232, RS-485 2-wire, RS-485 4-wire, RS-422 4-wire

Accessory kits

SC-OPE3BK (bezel kit), SC-OPE3CK (configuration kit)

*] The communication protocols ModBus RTU, DirectNet, DF1, and Metasys N2
are discussed in Chapter 4, “Using Networks for Inverter Operation.”
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Specifications
Kit Product SC-OPE3BK Bezel Kit The Bezel Kit includes parts for mounting the SC-OPE 3H
Components to either a panel or DIN rail, and the cable required to connect the SC-OPE 3H to an
inverter. o
e
Quantity Component Description for Bezel Kit C(-:;)
1 Bezel/housing for SC-OPE %
1 Gasket (for seal between bezel/housing and control panel door) e
1 O-ring (for seal between SC-OPE keypad and bezel/housing cutout)
1 Network Termination Board
1 Communication cable, 6’, connects SC-OPE to inverter
1 Connector plug (for RS-485 port connections and external +5V power)
4 Mounting screws for bezel/housing, 6-32 thread x 1 1/4”
4 Nuts for mounting screws, 6-32 thread
4 Lock washers for mounting screws, 6-32 size
2 Screws for back of bezel/housing (without DIN rail clips), 3-38 thread x 1”
2 DIN rail clips
2 Screws for back of bezel/housing (with DIN rail clips), 4-40 x 1 1/4”

SC-OPE3CK Configuration Kit The Configuration Kit includes software and com-
munications cable for using a PC to manage SC-OPE settings and inverter param-
eter transfers. Use of the communication cable requires a cable adapter (included).

Quantity Component Description for Configuration Kit
1 CD-ROM with Configuration Editor and firmware configuration files
1 Configuration cable, connects SC-OPE to PC, male RJ11 modular

connector at both ends (use with adapter below)

1 Cable adapter, 9-pin D-shell female to RJ11 female modular
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Frequently Asked Questions

Q. The inverter is already installed and running in my application (using the
standard Hitachi keypad). How easy is it to install a SC-OPE 3H and resume
control via its keypad?

A. It is easy to connect the SC-OPE and resume operation. See “Inverter Opera-
tion from the SC-OPE Keypad” on page 3—4.

Getting Started

Q. Will I be able to use the SC-OPE to initialize the inverter to restore factory
default parameters?

A. Yes, for SJ300 and L300P inverters. See “Restoring Factory Default Inverter
Settings” on page 3—32. Other inverters require using standard keypad
sequences or input terminal signals as described in their instruction manuals.

Q. Can I use the SC-OPE 3H with inverters that do not have a front panel
keypad bay for mounting operator interface devices?

A. Yes, but you will have to mount it remotely and use a communications cable
to connect the SC-OPE to the inverter. Order the bezel kit SC-OPE3BK, which
includes a bezel/housing and the necessary communications cable.

Q. Can I install or remove a SC-OPE 3H in an inverter while it is powered?

A. No — we recommend that you power off the inverter while installing or
removing a SC-OPE from an inverter. This precaution applies to any connection
on the rear connector of the SC-OPE. So, this includes connecting / discon-
necting the SC-OPE to the inverter via an interface cable.

Q. Can I connect or disconnect the SC-OPE 3H to a PC while the inverter is
powered?

A. Yes, the RS-232 connection to the PC is designed to connect or disconnect
while powered.

Q. When using the SC-OPE with a connection to a PC, must I always have the
SC-OPE connected to an inverter to get its power?

A. No, the SC-OPE’s bottom connector (10-pin) will accept external +5V power
from a supply you provide. Make sure it is regulated +5VDC power, +/- 5%.
But in most situations, the SC-OPE will get its power from an inverter. Note that
you must never connect the SC-OPE simultaneously to an inverter and another
power source.
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Q. Can I use the same SC-OPE hardware for SJ100, L100, SJ300, L300P, and
J300 inverter series?

A. The same SC-OPE hardware is applicable to the above inverter series. The
SC-OPE will mount in the keypad bay on the SJ300 / L300P series. The other
inverter series require separate mounting of the SC-OPE (no keypad bay).

Q. Can I use the same SC-OPE firmware for the SJ100, L100, SJ300, L300P,
and J300 inverter series?
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A. It depends on the models involved. There are three unique firmware sets:
1) SJ100 / L100 firmware

2) SJ300 / L300P firmware

3) J300 firmware

You can change between any two inverters that share the same firmware by
using only the SC-OPE keypad (for example, SJ00 and L100). To change
between inverters that use different firmware sets requires downloading a new
firmware set to the SC-OPE (see next question).

Q. Is is possible to download new firmware to the SC-OPE in the field?

A. Yes. You will need to order a SC-OPE3CK Configuration Kit, which is
licensed for use on a single PC to be used as a configuration station. Of course,
a single PC can configure as many SC-OPEs as you need (one at a time).

Q. Can I use a SC-OPE as a Copy Unit, that is — to copy parameters from one
inverter to another?

A. Yes. You can connect or install the SC-OPE into the inverter you want to use
as the source for parameter values. After reading the parameters to the SC-OPE
EEPROM (retentive) memory, you can write the SC-OPE’s memory contents to
another inverter. See “Copying Parameters Between Inverters” on page 3-25.

Q. Can I use the Configuration Editor on a PC to store inverter parameters to
a disk file?

A. No. A “configuration” file contains settings pertaining to the SC-OPE itself.
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Q. My application will need to use the network port at the bottom edge of the

SC-OPE. Can I still install the SC-OPE into the keypad bay of the inverter
(SJ300 or L300P)?

A. No. The network port at the bottom edge of the SC-OPE uses a 10-pin plug
connector. The inverter’s keypad bay does not have room for the plug con-
nector, network wiring, and network termination board (when required). There-
fore, you will need to plan for either panel mounting or DIN-rail mounting the
SC-OPE 3H in any networked application. The Bezel Kit SC-OPE3BK has the
required accessories for mounting the SC-OPE 3H via either method.
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Installation and Configuration

Introduction

Mounting
Options

Several mechanical mounting options for the SC-OPE are available. The proper
option for your application depends on its requirements as described in the table
below. Additional guidelines are on the following page.

Application Description
AR (Gl Inverter Tybe Use Network Port, | Use Network Port,
yp RS-485 RS-232

s Mount to Inverter SJ300 / L300P only No Yes
_S g Panel Mounting All inverters Yes Yes
© D>
T E DIN-rail Mounting All inverters Yes Yes
23
C
]

C

®

After the SC-OPE is mounted in the method appropriate for your application, be
sure to read the remaining sections in this chapter, starting on page 2—15.

Mount to Inverter Panel Mounting

See “Mounting the SC-OPE to
an Inverter” on page 2-5.

See “Panel Mounting the
SC-OPE” on page 2-8.

DIN-rail Mounting

= . .
See “DIN Rail Mounting the
- SC-OPE” on page 2—-12.
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The guidelines for selecting the mounting options are:

* Only the SJ300 and L300P inverter families have the proper keypad bay to accept
the SC-OPE for direct mounting. SJ100, L100, and J300 inverters will require
remote mounting of the SC-OPE in all applications.

* If you want to use the SC-OPE’s RS-485 network port, you must mount the
SC-OPE separately from the inverter. This is to accommodate network cabling and
a network termination board where applicable. Either the panel mount option or the
DIN-rail option will work.

 Ifyou only want to use the SC-OPE’s RS-232 network port, any mounting option
is permitted.

+ If the inverter will be mounted in an enclosure (panel), we generally recommend
panel-mounting the SC-OPE. This will provide easy operator access to the keypad,
including access to the RS232 port for updating the SC-OPE configuration.
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* The Bezel Kit contains the bezel/housing mounting hardware and the network
accessories for using the RS-485 port. After performing the basic mechanical
SC-OPE mounting you will be ready to make the network connection. See “Setting
Up a Network Interface” on page 4-2.

Caution: Be sure to power OFF the inverter before performing wiring changes to
the inverter or SC-OPE 3H, including connecting or disconnecting the SC-OPE
from the inverter. Otherwise, erratic operation or damage to either unit may occur.
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Comm Port
Introduction

The SC-OPE has two logical serial ports and three physical (connector) ports.
Therefore, it is essential to understand the function and location of the SC-OPE
serial ports.

 The inverter port is located at the top rear edge of the SC-OPE. It must be con-
nected to a single inverter in every application. This serial port is dedicated to
communicating with the inverter.

» The network port is logically one port, but it is available on two different connec-
tors. The front modular RJ11 connector is an RS-232 network port. The bottom ter-
minal strip connector is an RS-422/485 port. Since these two network ports are
logically one port, only one of them may be in use at any time (or you may use
neither of them).

Front view Rear view

° oo
D\\

™ Inverter port

L4 L4 :Iv—Fl
Network port, Network port,
RS-232 RS-422/485

* The SC-OPE automatically detects a connection to a PC (running the Configura-
tion Editor) on the RS-232 network port and communicates with it via a proprietary
protocol. This does not rely on the current factory network configuration in the
SC-OPE. Of course, do not attempt to communicate with the SC-OPE via the Con-
figuration Editor and a factory network protocol at the same time.

Note: The SC-OPE's RS-422/485 port cannot be used for communications to the PC
Configuration Editor software. You can only use the RS-232 port.
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Mounting the SC-OPE to an Inverter

The SC-OPE 3H can be mounted directly to the
inverter housings in the case of SJ300 and L300P fami-
lies. This is ideal for stand-alone inverter applications
(not on a factory network) or laboratory areas in which
the inverter is not mounted in a panel enclosure. If the
inverter is in a larger enclosure, note that mounting the
SC-OPE to the inverter will require panel interior
access to use the keypad.

To mount the SC-OPE to an inverter:

1 Remove the standard Hitachi keypad and panel filler plate. The keypad latch is
located at its top edge. Press the keypad latch to release. Be sure to put the keypad
and filler plate in a safe place in case they may be needed later.
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Standard keypad Keypad Latch

. Keypad Bay
F|| |er HITACHI
Plate * ;

2 Clear the keypad bay of any dust and debris.

3 Remove the SC-OPE from its packing material. Take care not to touch any com-
ponents on the circuit board to avoid potential static damage.
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4 Slide the SC-OPE partially into the
keypad bay as shown. As you do this
step, keep the SC-OPE front keypad par-
allel to the inverter front panel. The goal
of this step is to ensure the RJ45 inter-
connect in the inverter’s keypad bay
aligns with and is partially engaged with
the top connector on the back of the SC-
OPE. If this is not achieved, the intercon-
nect will bind and make the next two
steps impossible to perform.

5 Press along the SC-OPE bottom edge
to engage the retention latches in the
keypad bay. Do not allow the SC-OPE’s
top edge to slip out of the keypad bay
during this step (would cause the RJ45
interconnect to mis-align).

Installation
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6 Press along the top edge to complete
the SC-OPE installation in the inverter.

A proper installation will leave no gaps
between the SC-OPE and the inverter
front panel as shown below.

Press

Press

Press

Press
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Mounting the SC-OPE to an Inverter

7 To remove the SC-OPE from the
inverter, press the retention latch at the
top on the SC-OPE housing. One tech-
nique is to grasp the SC-OPE at the
bottom edge and use the thumb to press
the retention latch as shown.

uole|elsu|
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8 Disengage the bottom retention latches
and remove the SC-OPE uniformly in
order to avoid mechanical binding.
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Panel Mounting the SC-OPE

Ty

The SC-OPE will be panel mounted in most applications. Panel mounting provides
convenient operator access to inverter control while protecting the inverter inside
an enclosure / control panel. Also, mounting the SC-OPE remotely from the
inverter is required in network application to facilitate network wiring and termina-
tion. You will need a Bezel Kit to panel mount each SC-OPE device.

Tip: We recommend initial mounting of the bezel/housing without the SC-OPE
keypad. This protects the electrical components from dust, debris, and unnecessary
handling until the bezel/housing installation is complete.

To mount the SC-OPE into a control panel or operator panel:

1 Use the dimensions in the diagram below to mark the cutting and drilling loca-
tions on the panel. Dimensions are in mm (inches) format.

137 (5.39)
Panel opening Mounting hole,
dimensions |<7 123 (4.84) 4" dia. 4 (8.16),
/ 4 places, for

_A_$ Fe oo N ——1$ 6-32x 11/4”
screw

143
133 Bezel/housing
(5.24) thru-panel 141 (5.55)
dimensions

| |
| |
| |
| |
| |
| |
(5.63) : :
| |
| |
| |
| |
| |

— 121476 |
1 (0.04)

1(0.04 ’4—
Clearance, SC-OPE
to panel opening
perimeter

v

<
|
|‘
P—
<
L - — —

Note: Be sure proper clearance behind the SC-OPE mounting location exists and
that the cable from the inverter will be long enough to reach the mounting location.
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An example panel cutout is shown to the right. Be
sure cutout lines are level and square with the
control panel edges. Clean any debris from the
edges and holes before proceeding.

2 Place the gasket (included in the Bezel Kit)
around the inside perimeter of the bezel/housing
as shown. Align the holes in the gasket with the
ones in the corners of the bezel/housing. This
gasket provides a seal between the bezel/housing
and the panel’s front surface.
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Tip: We recommend installing only the bezel/
housing into the panel at this point. The SC-OPE
will be installed into the bezel/housing later in this
procedure.

3 From the front side of the bezel/housing, insert
the four mounting screws through the housing and
the gasket. This will serve to maintain alignment
between gasket and housing for the next step.

Screw,
6-32x11/4”

— Bezel/housing
flange

Bezel/housing ~_{

/

Nut Lock
washer

Panel door Gasket
seal
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4 Now, take the bezel/housing and gasket
assembly and insert it into the panel opening as
shown.

5 On the back of the panel, use the lock washers
and nuts (provided in the Bezel Kit) to secure the
bezel/housing to the panel.

6 Locate the O-ring seal in the Bezel Kit compo-
nents and orient it as shown (below, left). The seal
ensures a tight fit between the SC-OPE and the
bezel/housing.

7 Carefully stretch the O-ring around the SC-OPE
and situate it in the perimeter stepped channel as
shown (below, right).
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8 Take the SC-OPE and tilt it into the bezel/housing opening in the panel, latching
the bottom edge first as shown (below, left). Then push the top of the SC-OPE
keypad to engage the upper latch (below, right).
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9 Secure the SC-OPE to the bezel/housing
with the two 3-38 x 1” screws (included in
the Bezel Kit).

To remove the SC-OPE from the bezel/housing (at a later time):

1 Unfasten the two screws on the back of the bezel/housing (below, left).

2 While ensuring the SC-OPE does not fall freely out of the bezel/housing, press
gently on the modular connector from the rear of the unit as shown (below, right).
This will unfasten the upper latch in the bezel/housing.
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DIN Rail Mounting the SC-OPE

The SC-OPE can be mounted to a DIN rail as
shown. This option is ideal for mounting in a
panel when use of the keypad is primarily for
service technicians rather than machine operators.
The required bezel/housing and DIN rail clips are
included in the Bezel Kit.

To mount the SC-OPE to a DIN rail:

1 Secure the DIN rail to a solid surface. P — — .

|
. . I f
* Attach the DIN rail (fasteners not included) : c earggfgglrfa o :
|
|

at the points shown to keep the DIN rail from
twisting when installing/removing the SC-
OPE.
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» Ensure the space available has adequate
clearance for the SC-OPE bezel/housing.

» Ensure keypad access will be suitable for a Recommended

technician or operator. attachment points

2 Locate the O-ring seal in the Bezel Kit components and orient it as shown
(below, left). The seal ensures a tight fit between the SC-OPE and the bezel/
housing.

3 Carefully stretch the O-ring around the SC-OPE and situate it in the perimeter
stepped channel as shown (below, right).
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DIN Rail Mounting the SC-OPE

4 Insert the SC-OPE into the bezel/housing. You can use the square modular con-
nector and corresponding opening to verify the orientation of the two parts. Begin
with the SC-OPE bottom edge as shown (below, left), engaging the two internal
latches at the bottom of the bezel/housing.

5 Tilt the top of the SC-OPE into the bezel/housing and latch (below, right).

Tiltin and press
to latch

Insert and latch
bottom edge first

6 Attach the two DIN rail clips using the two 1 1/4” x 4-40 screws included in the
Bezel kit. Be sure to orient the clips with the hooked ends pointing upwards as
shown (below, left). This will allow you to hang the SC-OPE from the top edge of a
DIN rail and press against the rail to latch in the bottom edge as shown (below,
right)

Top edge

Bottom edge
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7 Mount the SC-OPE to the DIN rail. First, hang the tops of the DIN rail clips over
the top edge of the rail. Then push inward on the lower part of the bezel/housing to
latch the SC-OPE to the DIN rail.

Press in to unlatch from rail

! !
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Press in to /atch to rail

8 Removal of the SC-OPE from the DIN rail is accomplished by pressing on the
front top edge of the SC-OPE bezel/housing. This acts as a lever to unlatch the DIN
rail clips at the bottom edge of the rail. This capability requires that the DIN rail be
mounted securely to a solid surface as described in Step 1.

The next section shows how to connect the SC-OPE to the inverter.
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Connecting the SC-OPE to an Inverter via a Cable

The panel mounting and DIN rail mounting options for SC-OPE installation require
the use of a cable for SC-OPE-to-inverter communications. A cable is included in
the Bezel Kit for this purpose.

Note: DIN-rail mounting the SC-OPE leaves a small clearance for the cable to exit.
Standard modular connectors (such as Hitachi cable ICS-3) have an end connector
too large to fit between the SC-OPE and the wall behind it when DIN-rail mounted.
Be sure to use the cable supplied in the Bezel Kit.

To connect the SC-OPE to an inverter via a cable: %
>
1 Carefully remove the modular interconnect in the inverter’s modular as shown. g %
Be sure to grasp the latching prong such that it releases the connector for easy <§' g
removal. 8 S
o
A Caution: DO NOT use excessive force to remove the modular interconnect. Other- >
wise, damage to inverter circuitry may occur.

Connector latch

Modular RJ45 interconnect
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2 Plug the cable (included in the Bezel Kit) into the inverter’s communication port
(L300P shown below, left). The connector location for SJ100/L100 families is
under the inverter housing.

3 Connect the other end of the cable to the SC-OPE as shown (below, right). If DIN
rail mounted, you’ll need to temporarily detach the SC-OPE assembly from the
DIN rail for connector access.
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Powering the SC-OPE via a Dedicated Supply

If you have already connected the SC-OPE to an inverter (described in the previous
section), the SC-OPE will have the communications and power it needs to operate
the inverter. In any of the mounting configurations and normal use, the SC-OPE
gets its operating power from the inverter. However, it may be desirable in some sit-
uations to power the SC-OPE when an inverter is not available. For example, you
could connect a PC to the SC-OPE and configure it (described later in this chapter).
This section will show you how to power the SC-OPE using an alternate method.

A Caution: Do not connect the SC-OPE to an inverter and also connect a power
supply to the SC-OPE at the same time. Otherwise, there is the danger of damaging
the SC-OPE or the inverter circuitry.
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To connect an external supply to the SC-OPE:
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1 Locate the 10-pin connector plug (supplied in the bezel kit).

2 Acquire a fully regulated 5VDC supply, +/— 5% (4.75V min. to 5.25V max.)

3 Connect the power supply to the 10-pin connector as shown below (GND to
pin 10, +5V to pin 9).

4 Plug the connector into the network port of the SC-OPE.

10987654321

| LITTIIIT]]

Network Port, RS-422/485 Connector

]

SC-OPE Bezel/

Connector Plug Housing Assembly

(terminal screws |109 87654302 1| (keypad facing
facing down) down)
GND Vce
GND +5V

External Power
Supply
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Connecting the SC-OPE to a PC

The Configuration Kit includes a cable for connecting a PC to a SC-OPE. The
typical connection will use a standard PC serial port, connecting it to the SC-OPE’s
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front network port (RS-232).

Serial cable

9-pin D-shell

To connect the SC-OPE to a PC:

Adapter, modular to

To inverter

1 Ensure the SC-OPE has a power source. In most applications it will be connected
to the inverter (see page 2—15). Or, you may use an external power supply if an
inverter is not available (see page 2—17). Do not use both power source connections

at the same time.

2 Plug one RJ11 modular end of the cable
into the cable adapter as shown.

3 Plug the other end of the cable into the
SC-OPE’s RS-232 port as shown.

4 You have two options in connecting the
opposite cable end to a PC:

» For shorter distances, connect the
adapter end of the cable directly to a 9-pin
RS-232 port connector on the PC.

 For longer distances, connect a standard
serial cable between the adapter and an
RS-232 port connector on the PC.

Note: The SC-OPE will communicate with its
Configuration Editor in a PC via the RS-232
port. Do not attempt to use the Configuration
Editor over a factory network.
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SC-OPE Configuration Editing

Introduction The SC-OPE 3H contains firmware which enables it to communicate via a partic-
ular factory network protocol and with a particular inverter family. Additional set-
tings configure the SC-OPE’s Quick Menu, Startup Screen, and Help Screen. You
may need to change the SC-OPE configuration from the factory defaults for your
application.

The compatible inverter families are:

» SJ300 (factory default)

Q
3
. L300P oz
58
. SJ100 &5
58S
. L100 =
=}
. 1300

The compatible factory networks are:
 DirectNet

* Allen-Bradley DF1

* ModBus RTU (factory default)

* ModBus ASCII

* Metasys N2

A SC-OPE configuration specifies an inverter family and a network protocol (along
with associated baud rate, etc.) Even though each configuration contains a network
selection, you may operate a SC-OPE and inverter without making any factory
network connection.

Basic SC-OPE configuration settings may be edited with the SC-OPE keypad. The
Configuration Editor (PC software) provides access to all configuration settings,
and it can transfer configurations between the SC-OPE and PC.

Note: A SC-OPE configuration does not contain inverter parameter settings. You
can use the SC-OPE as a “copy unit” (upload parameters from one inverter and
download them to another inverter). Since inverter parameters are not part of a
SC-OPE configuration, a SC-OPE configuration file saved to disk does not store
inverter parameters.
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Installing the
Configuration
Editor

The Configuration Kit includes an installation CD-ROM, serial cable, and cable
adapter. This is all you will need to connect a PC to the SC-OPE and edit the
configuration.

To install the SC-OPE Configuration Editor software:

1 Insert the software installation CD into the CD-ROM drive in your PC. If the
drive is configured to auto-run, the installation will automatically begin, and you
can skip to step 7.

2 If the CD-ROM does not auto-run... From Windows’ desktop, click Start > Run.

3 In the Run dialog, click Browse... Browse HE
Lockin |29 010323_1000 (F) - =1

(21 program fies
=

4 In the Browse dialog, navigate to the CD-  [Zean
ROM drive letter (typically D:) and click E

Open.
5 Click (select) the file “setup” and click Fie pare:  [retn S 1]
Open Files oftype:  [Programs 2 |

6 In the Run dialog, the filename path
“D:\Setup.exe” will appear in the Open
field. Click OK.

7 Follow the on-screen instructions in the
installation dialog boxes. You will have the
choice of the install directory destination

Editor - Install5 hield Wizard

Welcome to the InstallShield Wizard for
5C-DPE 3 Configuration Editor

C-OPE 3 Configuration
dick Neat,

and program folder.

8 Click Finish when the installation is com-
plete, and remove the CD-ROM from the
drive.

protectsd by copyright lsw and

WARNING: This
inkernation:
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Uploading a
Configuration

(Optional) To create a desktop shortcut to the Configuration Editor:
1 On the desktop, right click and select New > Shortcut from the menu.
2 In the Create Shortcut dialog box, click Browse...

3 In the Browse dialog box, navigate to the s
installation directory. Example: Ll BT B

C:\Program Files\Hitachi\Scope e

4 Click (select) the Editor file and click

Open. Filegame:  [Editor Open
Fies of ype:  [Programs | Cancel

5 In the Create Shortcut dialog box, click
Next.

6 In the Select a Title for the Program dialog Box, enter a name such

as “Scope 3 Editor.” and click Finish. The new shortcut will be on the

desktop. SC-OPE 3
Editar

Using the Configuration Editor requires that you have performed basic setup tasks
(per the procedures given in prior sections in this chapter).

To prepare to edit a SC-OPE configuration:
1 Install the configuration software on the PC.

2 Connect the SC-OPE to the inverter (either through direct mounting or via the
cable supplied in the Bezel Kit).

3 Connect the SC-OPE to an open serial port on your PC, using the cable supplied
in the Configuration Kit.

PC with Configuration Editor
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To upload a configuration from the SC-OPE to the PC:

1 From Window’s desktop, click Start >
Programs > Hitachi > SC-OPE 3 Editor.
Then the SC-OPE 3 Configuration Editor
window will appear. Initially empty, the
window area will eventually contain config-
uration window(s) when you have uploaded
or created new ones.

2 Select the COM port which the editor
will use to communicate with the SC-OPE.
From the editor’s menu, click Editor > Set
COM Port Option > COM1 (or COM2,
COM3, or COM4) as needed for your PC.

If you select a COM port which is already
in use on your PC, an error message will
appear. Click OK and repeat this step,
selecting an available COM port.

3 Turn on power to the inverter, thus pow-
ering the SC-OPE. Ensure the motor (if

% SC-DPE 3 Configuration Editor

File Transter [[EERNY Window Help

E 4 Part Option COM1
Set Directory Options: mﬂﬂ\‘)

COM3

COM4

ERROR MESSAGE:

ion Emor!

connected) is not rotating at this time (press the Stop/Reset key if necessary).

Note: The SC-OPE can only communicate with an inverter of the type specified in
its configuration. If your SC-OPE is connected to a different type of inverter, the
SC-OPE will not power up to normal operation. However, you can still re-configure
the SC-OPE for proper operation by following this procedure.

4 Press the Mode key for 4 seconds to place the SC-OPE in Configuration Transfer
Mode. This mode permits you to transfer SC-OPE configurations to/from the PC.

=] B

Confiz Transfer Mode
Moitina for PCL..

. MODE kew for

Confiauration merid.

(4 seconds)

Note: More information on SC-OPE operating modes is in Chapter 3. This section

covers only the essential mode changes for configuration tasks.
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5 From the Configuration Editor’s menu, SRRz
click Transfer > Upload Configuration. A Cornect the Configuistion Cable from the P ssrial por
to the SC-OPE 3 and place the SC_OPE 3 in Config Transfer Maode
: : : [hodd dovirt the MODE key urtl Carfig Traresfer Mode message appears).
dialog box appears which reminds you to do
the setup tasks covered in the steps above.
Click OK.

Press Ok when ready.

At this point the Editor will attempt to communicate with the SC-OPE and upload
its current configuration to the PC. If the upload is successful, you’ll see the con-

firming messages below.

Information

@ Upload Complets!

Uplood Comrlete

Press MODE kew for
Confiswration menu.
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If the upload is not successful, correct the problem (such as serial cable connection
incorrect, etc.) and repeat the above steps.

6 Click OK in the Information dialog box and the Configuration Editor will display
the uploaded configuration in its own window, displaying primary information in
the fields as shown. Each settings group can be edited with the corresponding Setup
button. The next several sections discuss editing individual configuration setups.

$& SC-DPE 3 Configuration Editor
Fle Configwe Iransfer Editor Window Help

% Untitled [ ] —
SC-OPE Configuration

Configuration Description
5J300

Inverter Type Selection Hetwork Port Conliguation 5.1,
Inverter Type Fort Frotocol

|smn Selies Inverter IMEIasys N2

Firmuare Version Port Address

[204 |2

Guick Menu Configurstion g, Sttup ScreenandHeb 5oy |
Sereen Configuration
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Inverter Type
Configuration

The SC-OPE firmware contains the software that enables it to communicate with an
inverter. Three unique firmware sets provide SC-OPE communication capability:

1. SJ100/L100 firmware
2. SJ300/L300P firmware

3. J300 firmware

When you use the Configuration Editor to configure the inverter type, a Download
Configuration operation will automatically load the appropriate firmware to the
SC-OPE. In the cases of 1) and 2) above, you can change between the two corre-
sponding inverter types that share the same firmware by using only the SC-OPE
keypad (for example, SJ00 and L100). This provides some flexibility without
having to use the Configuration Editor in every inverter type change. A change of
firmware always requires the use of the Configuration Editor, however. When
staying within the same firmware type, you can use the SC-OPE keypad for conve-
nience.

This section shows both methods for configuring inverter type.

To change the inverter type selection by using the Configuration Editor:

1 In the Inverter type Selection group,

.
click the Setup button.

2 In the Inverter Type Selection dialog 300 ———
box, use the pull-down menu to select the
inverter type you want the SC-OPE to

L100 Series Irwerter

target for communications.

Note: You can configure the SC-OPE for an inverter type belonging to a different
firmware set than the type of inverter currently connected to the SC-OPE. However,
remember that SC-OPE operation will be restricted to Configuration Mode until its
firmware matches the type of inverter which is actually connected. In that case, the
SC-OPE will power up and only display the Startup Screen. Press the Mode key for
4 seconds to enter Config Transfer Mode.
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To change the inverter type selection by using the SC-OPE keypad:

1 Press the Mode key for 4
seconds to place the SC-OPE
in Configuration Transfer
Mode.

2 Press the Mode key again
(briefly) to get the Configu-
ration Menu. The Inverter
Port Cfg item at the top of
the menu list determines the
inverter type selection.

3 Press the Right Arrow key
to view the Inverter Port Cfg
sub-menu which consists of
one item: Inverter Type.

4 Press the Change Data
key. The “>” and “<” charac-
ters indicate that Change
Data is active.

5 Press the Up Arrow or
Down Arrow keys as needed
to select the new type.
Remember that only the
inverter type which shares
the current firmware in the
SC-OPE can connect (using
this method).

6 Press Store/Enter to accept
the new inverter type.

7 Press the Left Arrow key
to exit the Inverter Type sub-
menu.

(

MODE

—
4 seconds)

MODE

CHANGE
DATA

SSACIRY,

STORE
ENTER

]

Confia Transfer Mode
Moitins for PCo..
Fress MODE kew for

Confiauration menu.

Confiauration Mernu

Irnverter Port Cfa

Confisuration Merua

Irmeer ber Tare
SIZEE Series

Confisuration Merua

Irnerier Tors
HETZEE Seriesd

Confisuration Merua

Irnerter TaFs
LEBE Seriesd

Confisuration Merua

=
A T o

~

Confi=gration Mera
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8 Press the Down Arrow - . B
key twice to access the Store Lonfisuration Menu
Configuration Menu Item. Store Confisuration

Press twice [Enter]

9 Press the Store/Enter key

to store the configuration Confiauration Metu

STORE

change. ENTER Store Confiauration
Confisuration Stored
Network Port Network port configuration is only necessary when connecting the SC-OPE to a
Configuration factory network. SC-OPE communications to the Configuration Editor is automatic

(does not require network port configuration). This section shows how to configure
the network port using the Configuration Editor or using the SC-OPE keypad.
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To configure the network port by using the Configuration Editor:

1 In the Network Port Configuration group, S ——

click the Setup button. The Network Port dialog T P
box will appear. HodBus FTU - | —
™ Disable Metwark Control on a Keypad Stop
2 In the Port Protocol field, click the desired rBaudRate——  Stop Bits—| fde—
. . 0 1 = RS232
factory network protocol in the list. s £ R5485 Ziwie
600  R5485 4wie
. [ Data Bit:
3 Please refer to Chapter 4 for a complete dis- 1200 :i || o R sz
cussion on the remainder of the settings and the P .
related wiring diagrams, network termination - e
considerations, etc. € Hona
9600
+ Even
15200 ~ od

Note: The configuration edits do not affect the
SC-OPE until you download the new configura- o RJ ol
tion to the SC-OPE.

To configure the network port by using the SC-OPE keypad:

1 Press the Mode key for 4

seconds to place the SC-OPE Eﬂ:‘i % .iar'uzlr :Ir::ffE'F Moce
in Configuration Transfer Presz MODE kew for
Mode. Corfisuration menu.

(4 seconds)
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2 Press the Mode key again . -

(briefly) to get the Configu- Comfiauration Menu

ration Menu. Irwerter Port Cfa
W

3 Press the Down Arrow

key once to view the second Confisuration Mehu
list item, Network Port Cfg. Q MHetwork Port Cfa

"
S

4 Press the Right Arrow key . - )
to view the Network Port Comfiauration Menu g -
Cfg sub-menu list. [:> Metwork Protocol S &
. Modbus BETU Q@
5 Access the desired 5 g'

%".

=}

network port attribute item
by using the Up and Down

arrow keys.

The list includes:
* Network Protocol (factory network)
* Network Address (node address 1 to 255)
* Network Port Type (RS-232, RS-485 2-wire, RS-485 4-wire, RS-422 4-wire)
* Network Config (baud rate)
* Network Config (data bits)
* Network Config (parity)
* Network Config (Stop bits)
* Network Config (Flow control)
* Network Config (RTS delay)
» Network Port Mode (master/slave)
* Network Max Gap Time

» Stop Key Action (enables or disables keypad Stop key during network control)
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6 Press the Change Data key
to begin editing a setting.

7 Use the Up and Down
Arrow keys to change the
setting selection.

8 Press the Store/Enter key
to accept the new setting.

9 Press the Left Arrow key
to exit the Network Port Cfg
sub-menu.

10 Press the Down Arrow
key once to access the Store
Configuration menu item.

11 Press the Store/Enter key
to store the configuration
change.

CHANGE

STORE
ENTER

B <> [d

STORE
ENTER

% < O

Confi=gration Mera

Hetwork Protocol
Fiocbegs BT

Confisuration Merua

Hetwork Protocol
sHrectMetd

Confiauration Mernu

DirectMeat

Confisuration Merua

Hetwork Port Cfa

o, ",
S

Confisuration Merua

Store Confiauration
[Enter]

Confisuration Merua

Store Confisuration
Confiauration Storec

~
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Quick Menu The SC-OPE’s Quick Menu presents a subset of the inverter parameters for moni-

Configuration toring or editing via the keypad in normal operation. The single key Quick Menu
provides fast access to a circular list of up to 32 items. The factory default Quick
Menu can be edited with the Configuration Editor to provide a custom menu for
specific applications or market segments. For example, a Quick Menu which is
optimized for HVAC applications will be different from a menu optimized for a
pumping station.

To configure the Quick Menu:

1 In the Quick Menu Configuration group,
click the Setup button. The Configure Quick

% Configure Quick Menu !E

o
>
. . fdd | Insert | Delete | Edit | % >
Menu dialog box will appear as shown. The o &
: : - | Mum__| Quick Menultem | 30
list of parameters is the current Quick Menu 1 00 3 a5
. c =
in the SC-OPE. 2 S o
3 Al03 Base Frequency S
4 A004 Max Frequency o
2 Use the buttons at the top of the Configure 5 A041 Torg Boost Sel >
. . . B A042 Man Torg Boost
Quick Menu dialog box to change the list: 7 £044 T3t Ctl Method
8 ADBZ Motor Walkage
. . 9 HO04 Tst Mir Pal Sel
* Add - Click Add to add a new item to 1 FO02 1<t Accel Time
the bottom of the menu list. Select the new n FO03 15t Diecel Time
i 12 BO0E Open-Phasze Sel
parameter from the pop-up menu and click 13 B012 E-Therm Level
0K 14 B0 Stop Mode Sel
. 15 D005 Inp. Terminals
18 D00 Out. Terminals
¢ Insert— Click Insert to insert a new item 7 Trip History
just above the currently selected item in the
. Drefault Ok Cancel
menu list. Select the parameter from the | L |
pop-up menu and click OK.

* Delete — Click Delete to delete the currently selected item in the menu list.

+ Edit — Click Edit to replace the currently selected item in the menu list. Select
the new parameter from the pop-up menu and click OK.

* Default — Click Default to restore the factory default list.

» Cancel — Click Cancel to discard edit(s) to the Quick Menu Configuration in
the Editor.

* OK - Click OK to apply the changes (Add, Insert, Delete, Edit, Default) to the
configuration.

Note: The configuration edits do not affect the SC-OPE until you download the new
configuration to the SC-OPE.
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Startup Screen
and Help Screen
Configuration

The SC-OPE features two user-configurable information screens. The Startup
Screen is displayed momentarily at powerup. The Help Screen is displayed (during
normal operation) when you press the Help key on the keypad. These configurable
screens are suited for editing by OEMs for their specific application areas.

------------------- For assistances call
HITACHI AMERICAs Ltd Hitochi Americos Lid
SC-0OFE ZH_-LI06P 1-914-£31 - 0568
----- Ver 2.18 -----

Startup screen (default) Help Screen (default)

To edit the content of the Startup and Help Screens:

1 In the Startup Screen and Help Screen R E i Soreons i
Configuration group, click the Setup button. Sttty Soren
The Edit Screens dialog box will appear. ———

Hitachi America,. Inc
. . . . SC-O0PE xx — 5SJ348
2 To edit a line in the screens, click the =

cursor in the appropriate field and enter (or

edit) the existing content. Help Screen

For assistance. call

Hitachi America, Inc

Note: The bottom two lines of the Startup 1-914-691-0608
Screen have fixed content and cannot be
edited.
Detal ok s | Carcel

3 Click Default to restore the screens to
display the factory default content as shown

above.

4 Click OK when you have completed the screen content edits.

Note: The configuration edits do not affect the SC-OPE until you download the new
configuration to the SC-OPE.
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Downloading a
Configuration

The previous sections describe how to upload and edit a configuration. To actually
update the SC-OPE’s firmware, you must download the new configuration from the
PC to the SC-OPE.

To download a configuration from the Editor:

1 Ensure the SC-OPE is in Config Transfer Mode (will display screen as shown
below). If necessary, press the Mode key for 4 seconds to place the SC-OPE in Con-
figuration Transfer Mode.

Confia Transfer Mods
Moitins for FC...
Fress MODE kew for

Confiauration merid.

(4 seconds)

2 From the Configuration Editor, click e
Transfer > Download Configuration. A Connect the Configuration Cable from the PC serial port

to the SC-0PE 3 and place the SC_OPE 3 in Config Transter Mode
dialog box appears which reminds you of [hold dowir the MODE key until Canfig Trarster Mode message appears)
transfer setup details. Click OK.

Press Ok when ready.

3 The Download SC-OPE Configuration
windows shows the transfer progress. When

. Starting Download..
complete, Clle OK Starting Configuration Mode...

(continued next page)

Abart

Information

@ Download Complete!
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When you have changed the inverter type in

Download 5C-0PE Configuration

a configuration (such as from “L100” to o
arting Download...
“gJ1 00”), a conﬁguration download gtamng Flash Download Made...
. ’ ] ownload!ng Buffer 1 of 8...
includes inverter-specific firmware for the Dovininading Buffer 2 of 8...
SC-OPE. The status message “Starting
Flash Download Mode” followed by =
“Buffer 1 of 8” etc. indicates the new Abort |

inverter-specific firmware is downloading.
The SC-OPE shows the buffer (block)
number which is currently loading. Moitirna for

Block 1 of 2

Note: Configuration uploads do not include
inverter-specific firmware. The Editor

installation already contains all inverter-
specific firmware files in its subdirectory
named “Download.”
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4 After downloading the configuration you may want to return the SC-OPE to
normal operation from Configuration Mode. Press the Mode key for 6 seconds as
shown.

HITACHI AMERICHs Lt
SC-0FE EH -%%EEP
----- 2.18 ===~

Yer

(6 seconds)
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SC-OPE Configuration Editing

Naming / Saving The editor has the capability to save
Configurations SC-OPE configurations to disk in your PC. SC-OPE Confiquration
Each configuration will have a unique file- Corfigurtion Description

name. Before saving a configuration, you [34300- Purping Stson

can enter a text Configuration Description
in the field provided as shown.

To save a configuration to disk:
1 From the Configuration Editor menu, click File > Save.

2 In the Save As dialog box, navigate to the desired directory, enter the filename,
and click Save. Each configuration uses the “*.prj” filename format.

Editor Options The Configuration Editor has options you can set based on your PC hardware and
your preferences.
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To select the COM port:

* From the Configuration Editor menu, click Editor > Set COM Port Option >
COM1 (use available COM port on your PC).

To set the directory options:

1 From the Configuration Editor menu,
click Editor > Set Directory Options. The

SC-0PE Configuration Directom

Current Directories dialog box will appear |C:APROGRAT4HitachnSCUPE Projeats Browse |
as ShOWIl. Inverter Firrweare Directony
IC WPROGRA™1M\Hitachit COPE \Download Brawse |

2 The SC-OPE Configuration Directory is
the default directory the Editor uses when
you click File > Save. Click Browse to nav-

Default 0K [ | Cancel |

igate to the directory of your choice.

3 The Inverter Firmware Directory is the directory within the Editor installation on
your PC which contains SC-OPE firmware versions specific to inverter families.
Change this directory ONLY if you have obtained SC-OPE firmware files and
located them in a directory different from the default installation directory.

4 Click Default if you want to restore the directory paths to the original ones in the
Editor installation.

5 Click OK to save the options for the Editor.
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Printing a
Configuration

Viewing Multiple
Configurations

You can print the settings which comprise a configuration. This feature is handy for
creating project documentation.
To print a configuration:

1 From the Configuration Editor menu, click File > Print.

2 In the Print dialog box, change any settings as needed and click OK.

In applications using multiple SC-OPE devices and configurations, you may have
multiple configurations open in the Configuration Editor. Each open configuration
file will have its own window.

To manage multiple configuration file windows in the Configuration Editor:

1 From the Configuration Editor menu, click Window > Tile, or Window >
Cascade, or Window > Arrange icons to display the configuration windows in cor-
responding fashion.

2 You can restore any minimized configuration window to bring it to the front.
From the Configuration Editor menu, click Window > <windowname>, where the
numbered list contains the configuration window names.
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Using the Keypad for Inverter Operation

Orientation to Using the SC-OPE

Using the The SC-OPE 3H keypad provides direct access to inverter control and programming
Keypad of parameters. The keypad layout arrangement shown below groups the keys into
functional groups — keys that perform similar or related functions.

monITor | | SPEK | IpRoGRAM
L J L SC-OPE
M/Iode Selection
' 7\ '
Parameter Editin CHANGE READ
g DATA MODE WRITE
STORE ESC
ENTER CANCEL HELP
Motor Control STOP HAND Manual/Automatic
RESET AUTO |—  Selection
|

SC-OPE Mode Selection The SC-OPE 3H has operational modes which are inde-
pendent of the attached inverter’s modes. These include Monitor Mode, Program
Mode, Quick Menu, Read/Write Menu, and Help. The five corresponding keys
provide immediate access to the respective mode; you can jump from any of the
modes to another with a single key press. Powerup of the SC-OPE always enters
Monitor Mode. The Mode key performs a fundamental role in mode selection by
switching the SC-OPE from its five normal modes to Configuration Mode and back
to normal operation (to Monitor Mode).

Inverter Operation
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Manual/Automatic Selection The Hand/Auto key allows the operator to select the
source device for the Start Run Command and the inverter frequency setting. Suc-
cessive Hand/Auto key presses sequence through a fixed set of selections. Source
devices include the SC-OPE keypad and the inverter input terminals.

Parameter Editing The Change Data key, Store/Enter Key, and Esc/Cancel key
work together to change inverter settings. When using these keys in Program Mode,
you can change inverter parameter values. When used in Monitor Mode, you can
change the output frequency (controls motor speed) of the inverter.

Motor Control The Start Run and Stop/Reset keys provide direct control over the
inverter’s output. These work independently of the SC-OPE’s five normal modes.
However, you cannot run the motor when in Configuration Mode.
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SC-OPE The SC-OPE 3H normal operational modes feature unique display output fields.
Normal Oper- Press the corresponding key to view the default or mode entry screen contents.
ating Modes

Monitor Screen (entry)

MONITOR

0o

= =

L AN
T e
[ R iy |
T
" it
7
i 1
w =
[y

Pl

s

Quick Menu (entry)

BUICE_MEML
6. EHz
auick > ead/Hrite Menu
[Enter]

Read/Write Menu
EFEAIVHEITE MEMU

i Feod EEPEOM Dato
P Write EEPROM Dota

5B
=1b
mlo

Program Screen (entry)

FEOGEAM MODE
B BHz

ondtor Mars

PROGRAM

i
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Help Screen (default)
For assistances coll
Hitochi Americos Lid
1-gid-a31 -8686

HELP

¢
y!

.

The diagram to the right shows the organization of the SC-OPE’s operating modes.
The line and arrows indicate that you can switch from any mode to any other mode.

SC-OPE Modes in Normal Operation

powerup
Read/Write




Using the Keypad for Inverter Operation

Inverter Operation

—
L
e

@

o

>

Q
X

o
e
e=]

o
=

n
o

Inverter Operation from the SC-OPE Keypad

Selecting
Keypad or
Network Control

An operator can run and program the inverter from the SC-OPE keypad. To achieve
unattended operation, the operator can configure the SC-OPE to send factory
network commands it receives on to the inverter. These can also run and program
the inverter. During network control, the SC-OPE’s keypad will be prevented from
editing parameters or running the motor in order to avoid a conflict with network
host commands. The diagram below illustrates control via keypad or network.

Inverter

SC-OPE

Network Host
Computer

Keypad

Factory Network ﬁ ‘\_O\Q_’
or

Building Network | Network Port |—O

|
> |
|
|

Control Method Setting

_________ J

The SC-OPE’s control

method setting is fundamental . BA
and very important to know. MONITOR ke CIF
Morm St

Its default setting is “Keypad
Control,” displayed in
Monitor Mode in the corner
of the display. It is not necessary to change this setting unless you have a factory
network connection and want the network host to control the inverter.

Control method setting

To change the Control Method setting:

PROGRAM

4 times

1 Press the Program key to
enter Program Mode.

PROGRAM MEMU
&.8H=
Mondtor Yars
)

2 Press the Down Arrow key
four times to arrive at the
Network Control menu item.

FROGRAM MEHU
. BHz
gpmnrk Cortrol
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3 Press the Right Arrow key
to access the first item on the
Network Control menu:
Control Method.

4 Press the Change Data key.
The “>” and “<” characters
indicate Change Data is
active.

5 Press the Down Arrow key
to select Network, or the Up
Arrow key to select Keypad
(see note below).

FREOGEAM MEHU
H, HHz
[:> Lot 51 Method

e

FREOGREAM MEMLU

g, 8Hz
Combrol Methood
FRearadd

FEOGEAM MEMU

. 8Hz
Control Method
Fhetuork

Note: For the purpose of following the discussion in this chapter, leave the Control
Method setting at “Keypad.” If you want a network host to control the inverter, set
Control Method to “Network” and refer to Chapter 4 for network control material.

6 Press Store/Enter to accept
FREOGREAM MEMLU

the new selection, or Esc/ 8. BHT
Cancel to abort the edit. @ witral Methoo

LEEn
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7 Press the Monitor Key to

return to the default powerup
mode of the SC-OPE. The MONITOR
Control Method setting will

be displayed in the corner of
the display.

Control method setting
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Choosing the The SC-OPE 3H has a Run Start key for operator-initiated rotation of the motor.
Direction of Pressing the Start Run key causes the SC-OPE to send a Run FWD command to the
Rotation inverter. Initiating a Run Rev command is not available from the SC-OPE 3H

keypad; HVAC and pump applications generally require one direction of rotation.
However, using the SC-OPE, you can program the inverter for either forward or
reverse rotation in response to the Run FWD command (Start Run key action).
Inverter parameter F004, keypad Run Key Routing, can be set to FWD or REV in
the inverter. This setting does not affect the inverter’s response to run commands
from other sources, such as intelligent inputs or network commands.

A Caution: In HVAC and pump applications, the motor is generally restricted to
operate in one direction only. If your SC-OPE is already integrated into a control
system by an OEM, changing the sense of direction for the Start Run key may
damage equipment run by the control system.

To configure the inverter direction via the Run key routing setting:

1 Press the Program Mode

5 key to enter Program Mode. F'E:I-":'E:EHHHEHU
56 PROGRAM) | Mamitor Yars
© T y

S5

3§

2 Eé 2 Press the Down Arrow key —

290 to reach the Parameters menu PROGRAM_MEML
£ 2 . B -z
L= item.

‘arameters

3 Press the Right Arrow key
to enter the Parameters sub-
menu list.

FREOGFEAM MEHLU

4 Press the Down Arrow key
several times until you reach
the Operation menu item.

FROGRAEM MEMLU
H. BH=z
Feralion

S

SIRVERCHT]

several times

5 Press the Right Arrow key
to enter the Operation sub-

FROGRAEM MEHLU
H. BHz
S OFer Mode Sel

0R

menu list.

N/
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6 Press the Down Arrow key
several times to access the
Run Key Routing menu item.

7 Press the Change Data key
to enable the Change Data
function.

8 Use the Up Arrow and
Down Arrow keys to change
the setting. REV and FWD
are the available settings.

9 Press the Store/Enter key
to accept the entry.

10Press the Monitor Mode
key. The display will prompt
you to save the change made
in Program Mode to the
inverter’s EEPROM.

11 Press the Store/Enter key
to save the parameter change
to the inverter’s retentive
memory (EEPROM).

12 Press the Start Run key to
run the motor. The display
shows the newly selected
direction of rotation per the
Run Key Routing parameter
setting.

\/

several times

CHANGE
DATA
'

STORE
ENTER

STORE
ENTER

FEOGEAM MERL

H, AHz
Fadd Bun Eew Eoutins
BFWD

FEOGEAM MERL

. 8-z
Fabd Bun Eew Eoutins
FFT

PROGRAM MEHLU
B, GHz

BAZS Tir.

»REV

Festrict

FEOGEAM MERL

H, AHz
BEES Dir. Eestrict
EN

Inverter Foromerers

howve besn chamsed.
Store to EEPEOMT
STORE ¢ CRMCEL

Irnverter Faromerers
howve besn chamsed,

Store to EEFPREOM?
s Shorirm Doto sk

5 . 8% 8. 08kK0
16,868 H, BEHz

e OFESFra:0PE EEY
Fome Le HoEew Chrl
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Motor Control
from the SC-OPE

Operating the inverter and motor requires proper parameter setup. If you have a new
application, it may be easiest to begin with the default parameters. Refer to the
inverter instruction manual and follow the Powerup Test given in the Installation
and Wiring Chapter.

To run the inverter from the SC-OPE keypad:

1 Press the Monitor Mode Status of Run command source
key to enter Monitor Mode. |/ Frequency setting source

2 Press the Hand/Auto key

successively until the Run and HAND
Freq. Source settings are both
set to “OPE” as shown to the

right. This means the operator interface (SC-OPE) is selected to generate Run FWD
and Run REV commands and to generate the basic inverter speed setting (parameter
F001). Leave the SC-OPE display in Monitor Mode.

In Monitor mode, the second  Desired output frequency  Actual output frequency
line displays the desired and

actual frequencies. You can

edit the desired frequency in

Monitor Mode, setting param- AUTO
eter FOO1 (Frequency Set-

ting) in the inverter.

3 Press the Change Data key

to edit the desired inverter fre- P 2 N P ik Ll
. s CHANGE g B, B B, BEHE
quency setting. The “>" and DATA IR Fa:0FE

" II
“<” characters indicate Horm Stor ! Eew Chrl
Change Data is active.

4 Use Right and Left Arrow
keys to move the cursor to the
digit you want to change.
Then use the Up and Down

Arrow keys to increment or
decrement the digit. This
example uses 10Hz. We recommend using a relatively slow initial speed.

Caution: Before running the motor, ensure the mechanical load can move freely
from obstructions and personnel. Otherwise, damage to equipment or injury to per-
sonnel may occur.
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5 Press the Store/Enter key to
accept the new desired fre-

STORE
quency. ENTER

6 Press the Start Run key. The
RUN LED should turn ON to
indicate the inverter is in Run
Mode. The monitor screen
will indicate the actual fre-
quency, motor direction and
status such as “Ramp Up,” “Const Spd,” “Ramp Down,” and “Norm Stop.”

7 Press the Stop/Reset key. The example motor profile below shows the keypad
command of motor operation. The Up Arrow and Down Arrow keys adjust the
motor speed (when the inverter frequency source is configured as the operator
keypad — SC-OPE).

Output Target freq., constant speed
Frequency - -----

v
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8 While the motor is

rotating, press a key for
another normal mode such PROGRAM (5. 2Hz)
as Program Mode. Note e

that the second line of the
display shows the actual
output frequency. This feature permits you to use other modes while still observing
the actual output frequency.
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Special
SC-OPE Modes

The SC-OPE 3H memory contains operating firmware and communications set-
tings. The operating firmware in the SC-OPE makes it specific to a particular
inverter family. This data can be transferred to or from a PC disk file called a config-
uration. The SC-OPE has a special Configuration Mode for use during a firmware
update. It is globally accessible from any of the four primary SC-OPE modes by
pressing and holding the Mode Key. The following diagram shows the relationship
of Transfer Mode to the other modes.

All SC-OPE Operating Modes

/ Special Modes \
DOP Keypad
Simulation
(Hold 6 seconds)
C

onfig menu

SC-OPE Check items
(Hold 4 seconds)

( Normal Modes

powerup

Monitor <

Program Diagnostics

Configure SC-OPE

Configuration

- /

v

Read/Write

—

The diagram shows that the Mode key transitions the SC-OPE between Normal
Modes and Special Modes, based on the duration of the Mode key press.

L)

* Press the Mode key and hold for 4 seconds to enter Configuration Mode. The
Config Transfer Mode is the beginning action (or mode) within Configuration
Mode. Config Transfer Mode provides PC-to-SC-OPE configuration data transfers.
Diagnostics and DOP operations are accessible from menu items from the Configu-
ration Menu. After entering either of these modes, you will need to reset the
SC-OPE to exit (see below).

* Press the Mode key and hold for 6 seconds to reset the SC-OPE and enter
Monitor Mode.




Program Mode

Program Mode

Programmable settings in the SC-OPE 3H include network port settings, SC-OPE
operational modes, and inverter parameter settings. Parameter changes initially
affect a copy of the inverter’s parameters in its RAM to be used for motor control. A
separate Store to EEPROM step writes any parameter change(s) to the inverter’s
non-volatile memory, so the changes are in effect upon the next powerup.

The Program Menu provides access to the programming capability outlined above.

To navigate through the Program Menu selections:

1 Press the Program key to access the Program Menu. Shown below, the bottom
two lines indicate the menu level and item to be programmed. The second line dis-
plays inverter output frequency during programming.

PROGRAM MEHL
> H.8H=z
PROGRAM Morditor Mars

2 Use the arrow keys to move up or down the list of items at the same level.

3 Use the left or right arrow keys to change levels.

_C
5 Q.
<5
o @
=
ol=a
S0
Ox
S

-k
9o
S
53
o

Program Menu Summary The Program Menu structure has up to four levels. A
summary of the Program Menu top level for all inverters is shown in the list below.
Within the Parameters submenu, the SC-OPE presents only the inverter parameters
which correspond to the inverter which is connected. A Program Menu map corre-
sponding to each inverter family can be found in the appendices in this manual.

Use Left and Right Arrow keys
to navigate to menu levels

(Level 1) (Level 2) (Level n)
PROGRAM| * Program Menu — * Monitor Vars 4’_E
» Parameters —>
» Status —>
Use Up and Down @ + Trips —» :'L[Jct;'rﬁf;?nas its

Arrow keys to navigate
through item lists at

each menu level Q

» Network Control —p ?eV:Q tl(l)stezgt;;arame-

« Software Lock —>

» Configuration Mode —p
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Program Mode
Example

Within Program Mode you can navigate to various parameters (see previous page)
and edit values or settings. The following general procedure shows how to navigate
to a parameter, Change Data (edit the value), and either Enter (accept) the new
value or Cancel (abort) the edit. The example edits A004 Max. Frequency.

To edit a parameter or setting in Program Mode:

1 Press the Program key to
enter Program Mode.

2 Press the Down Arrow key
to move down the list by one
item to Parameters.

3 Press the Right Arrow key
to view the first item under
Parameters: Initial.

4 Press the Down Arrow key
to view the second item under
Parameters: Base Setting.

5 Press the Right Arrow key
to view the first item under
Base Setting.

6 Press the Down Arrow key
several times until parameter
A004 Max Frequency
appears.

7 Press the Change Data key
to permit changing the data
from the keypad. The
symbols “>" and “<” indicate
Change Data is active.

PROGRAM

a v aw ol

Press x times

CHANGE
DATA

FROGRAM MEHU
H. BHz
ﬂﬁpitur Wors

FEOGEAM MEHU
3 -

B, 6
Faramete

FROGRAM MEHU
H. BHz
}ﬂjtiul

FROGEAM MEHL

FROGRAM MEHU
H. BHz
S Frea Set Methoo




Program Mode

8 With the Change Data .
operation pending, use the PROGRAM MENLU

4> i
Left and Right Arrow keys to <] [:> CiAE ngl.gH‘F—r' LS
move the cursor to specific Q e 1 e
digits. Increment or decre-

ment a digit by using the Up

Arrow or Down Arrow key respectively. In this example, make a small (safe)

change to the value, or leave it at its current value.

9 Press the Store/Enter key

to accept the new value for FROGRAM_MERL
STORE i, BHZ
A004 Max Frequency. Note ENTER SEE4 Moz Freausnow
that the “>” and “<” charac- S5H=z

ters are now absent; a Change
Data is no longer pending.

You can change one or more parameters in any Program Mode session. It is very
important to remember the following points:

* Program Mode changes to inverter parameters affect only the inverter’s present
copy of those parameters in inverter RAM. It will use these parameters for motor
control.

» Changes made to parameters in inverter RAM are not retained during inverter
power loss.
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The next major section, “SC-OPE and Inverter Memory Resources” on page 3—17,
describes how to more permanently apply your Change Data updates to the
inverter’s EEPROM, which are loaded to its RAM for use upon each powerup.
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Program Mode
Edit Permissions

Hitachi inverters have many user-settable parameters and functions. The inverter
monitors various conditions and signals to appropriately allow or prevent editing on
a parameter-by-parameter basis. At any point in time, each inverter parameter or
functions has an edit permission (allowed or prevented) associated with it. The
inverter enforces edit permissions when you use the standard Hitachi keypad that
comes with the inverter. When the SC-OPE is connected to the inverter, then the
SC-OPE monitors the same conditions and signals as the inverter would do in order
apply the same edit permissions.

Conditions and signals which determine the edit permission for each parameter are:
+ Software Lock Mode setting (B031)
* Inverter Run Mode / Stop Mode status

* [SFT] Software Lock intelligent input state (only when an intelligent input is
defined as [SFT])

* Run Mode Edit classification of standard parameters (as listed with check “[1”or
ex “[J” mark in the parameter tables in the inverter instruction manuals)

» Parameters in special categories, which include B031, FOO1, and the Multi-speed
parameters (Ax20, and A021 to A035)

The particular Software Lock Mode (setting B031) in use establishes the general
permission levels for all parameters. However, some parameters that directly affect
inverter output operation cannot be edited when the inverter is in Run Mode,
regardless of which Software Lock Mode is in use. In addition, the optional [SFT]
intelligent input state works in combination with the Software Lock Mode in real
time to modify the edit permission level. To determine when parameters can/cannot
be edited for various conditions, please refer to the inverter instruction manual sec-
tions on Software Lock Mode (B031) and the section on [SFT] intelligent input
operation.

Program Mode Behavior The SC-OPE monitors the conditions and signals listed
above during Program Mode use. It evaluates the edit permission (either allowed or
prevented) in real time for each parameter when:

+ ...you navigate to a parameter you want to edit and press the Change Data key, or

+ ...you have tentatively edited a parameter value and then press the Store/Enter key
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Note: The SC-OPE re-evaluates the edit permission for each parameter when the
Store/Enter key is pressed, because the state of the [SFT] input (if in use) could
change just after you press the Change Data key.

Change Data key The “> <” edit cursors normally appear after pressing the
Change Data key. If the current edit permission result prevents editing, the edit
cursors will not appear — indicating editing is prevented.

Edit allowed PEDEEQH_HDDE
BH=
///ﬁ:::Z, FEEY Max Freausnc
CHANGE : AHz <
— DATA
PROGREAM MODE \
H.8H=
FERL Moz Freausrcws
B cBHz —
CHANGE
DATA FROGRAM FODE
‘————— _ H.8H=

4 Moz Freausrncs

Edit prevented

Store/Enter key After pressing the Store/Enter key in an allowable edit, the “> <”
edit cursors normally disappear, leaving the new parameter value. If the current edit
permission result prevents editing, pressing the Store/Enter key will be the same as
pressing the Esc/Cancel key — the “> <” edit cursors disappear, and the value dis-
played returns to the original (actual) parameter value in the inverter.
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Edit allowed FROGREAM MODE
H. BHz
N /—V SR Hrl';-_ Frequerr
(...after editing the value) STORE G5H=
o ENTER
FEOGEAM MODE )
H.8Hz
P84 Mox Freausrnod
R SHE
STORE
ENTER PROGRAM FODE
- |-_':| |-1H_"

) FEEG Mox Freausmcws
Edit prevented = EAHzE
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Stopping the
Motor Before
Storing Edits
(SJ100/L100)

When you edit one or more parameter values and exit Program Mode, the

SC-OPE will first prompt you to store the changes to the inverter’s EEPROM. If the
motor is running at that time, the inverter (SJ100/L100 series only) will need to stop
the motor before performing the memory update. Rather than simply apply a free-
run stop, the SC-OPE will prompt you to stop the motor (applies controlled deceler-
ation). You can also choose to cancel the storing of parameters, which leaves the
motor running.

(...upon exiting Program Mode)

Irverter Parometers

hove besn chamsed,
Store to EEFROMT
STORE ¢ CAMCEL

Inverter in Inverter in
STORE ESC STORE
Stop Mode ENTER / =y \ ENTER Run Mode

Irnverter Parameters Irverter Parometers
hawe been chanzed. hawve been chanzed.
Store Lo EEFPROM? Stor motor nol?

ek Storins Dotao s STOF ¢ CRMHCEL

ESC STOP
CANCEL RESET

(Motor decels to stop)

Irnverter Parometers
have besn charsed,
Stor motor PoK’
wk Storine Doto S

L/

(Display for next mode)
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SC-OPE and Inverter Memory Resources

SC-OPE and Inverter Memory Resources

Overview The block diagram below shows representative memory resources in the SC-OPE
and inverter. Events or operations transfer parameter data among these resources.

SC-OPE Inverter
Firmware EEPROM RAM EEPROM Firmware
f i b~ p b~ p b~ p b~ p
i n I 1] I 0 [ 1] I 1]
i n i 1] i Nl i 1] i 1]
i n i 1] i 1] [l 1] i 1]
i i i < i i qi in) i i
i n i 1] i 0, [l 1] [l 1]
i 0 [l 1 [l Ind i 1] i 1
i i i i i 1 ] i i i
i i i i g N i i i
i Il i 1] i 1] | i 1] i 1]
\%_¢
Keypad D I
i -1 _____ a Motor Control

The SC-OPE and inverter memory resources operate according to the following:

* SC-OPE EEPROM It is the destination or source in Read / Write operations,
respectively. The EEPROM data is retained during power loss. This is required
when copying one inverter’s parameters settings to another inverter.
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* SC-OPE Firmware Stores the SC-OPE’s operating system, which includes the
protocols needed to communicate with specific inverter families. Updating the firm-
ware is necessary when you want to configure the SC-OPE to operate with a dif-
ferent inverter family (requires the use of a PC with the SC-OPE Configuration
Editor software).

* Inverter RAM The inverter’s scratchpad (temporary) memory area, which con-
tains parameters for real-time motor control. These parameters may be edited
during operation. However, the RAM does not retain data during power loss.

* Inverter EEPROM Stores parameters which are used in real time for motor
control in the inverter. Its contents are non-volatile — preserved during power loss.

* Inverter Firmware Contents include the factory default parameter values. When
you perform an initialization of the inverter to restore the factory defaults, these
default values are transferred from the firmware to the EEPROM.
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Data Operations The block diagram below shows data operations or events that transfer parameters
from one memory resource to another.

SC-OPE Inverter
Powerup
|
EEPROM RAM ,  EEPROM Firmware
g >t > b, ' §Y¢ >
: ! Write EEPROM data | § AN ! : !
p i i i
i b Read EEPROM data | | B i 71 &
7 N S
E % Parameter edits ; i ' g h | (I %
f i i i i i
i i i P b (i i
|
Keypad ! (I
| [
P | Initialization
h Store to EEPROM ! (factory defaults)
. SRR L s

* Read EEPROM data Transfers parameter values from the inverter EEPROM to
the SC-OPE EEPROM. This operation is available from the Read/Write Menu, and
is a component of the Copy Unit function of the SC-OPE.

» Write EEPROM data Transfers parameter values from the SC-OPE EEPROM to
the inverter’s EEPROM. This operation is available from the Read/Write Menu, and
is a component of the Copy Unit function of the SC-OPE.
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» Parameter edits Changes the value of (usually one) inverter parameter in RAM.
The inverter will operate with this changed value, but it will not be retained during
inverter power loss.

» Store to EEPROM Copies the inverter’s RAM image of all parameters to its
EEPROM. This step is necessary for any parameters edits to be retained upon the
next powerup of the inverter.

* Powerup Automatically copies the inverter’s EEPROM parameter image to its
RAM, where it is used in motor control and to receive operator parameter edits.

* Initialization This operation restores factory default parameter values in the
inverter by copying them from its firmware (permanent memory) to its EEPROM
(retentive memory) and RAM (working memory). This operation is available in the
Program Menu.
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Quick Menu Operation

The Quick Menu in the SC-OPE is a time-saving feature designed to group the most
often-used parameters for monitoring or programming for the operator. Accessible
with a single key press (Quick Menu key), the menu item list can contain up to 32

programmable items.

The last item on the Quick Menu list is fixed and special in that it enables you to

apply any data changes to the inverter. You may accumulate data changes (edits) in
either Program Mode or when using the Quick Menu. These accumulated changes
will be in the inverter’s RAM, and are pending transfer to the inverter’s EEPROM.

QUICK | * Quick Menu * A001 Freq Set Method
MENU . —

G : Programmable

. menu items

GO n

I
! » Store to EEPROM
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Note: The Store to EEPROM operation in the Quick Menu simply causes the
inverter to copy its working parameters in RAM fto its retentive memory (EEPROM).
In contrast, the SC-OPE's Read/Write Menu provides the transfer of all inverter
parameter settings to/from the SC-OPE's memory for transfer from one inverter to

another (“copy unit” function). See “Copying Parameters Between Inverters” on
page 3-25.
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Storing to
EEPROM

After any change to a parameter(s) value in the inverter’s RAM, an additional Store
to EEPROM operation is required to permanently update the inverter’s parameters
so they are in effect upon the next inverter powerup. Since the inverter uses the
RAM data in real time, only one Store to EEPROM operation is required before
powerdown. Note that each of the following operations edit parameter values RAM:

» Program Mode, editing any parameter value
* Monitor Mode, incrementing/decrementing the Output Frequency Setting (FO01)

* Monitor Mode, changing the Hand/Auto setting, which updates the Run
Command Source Setting (A002) and/or the Frequency Source Setting (A001)

Caution: Any keypad operation in Program Mode or Monitor Mode can only
change parameter value(s) in the inverter's RAM. In order for the inverter to
resume operation after a power cycle by using your latest parameters, it is essential
to perform a Store to EEPROM operation before leaving the SC-OPE and inverter.

To perform a Store to EEPROM operation:

1 Complete any desired parameter edits (will be in inverter’s RAM).

2 Press the Quick Menu key. )
CIITCE MEML
QuicK . B.BH=z
MENU ABE1 Frea Set Frea
[EMTER]
3 Press the Down Arrow key .
as needed to reach the bottom GUI L'}:"BHEEU
of the Quick Menu list for the Q T ,r & -|- o EEF =g
Store to EEPROM menu item
(or press the Up Arrow key

once; the list navigation is
also rotary in design).

press as
needed

4 Press the Store/Enter key I
to move (store) parameters STORE G L'I."'BMEEI-—.!
from the inverter’s RAM to ENTER "“1- are o EEPROM
its EEPROM. The status orimE odoto

“Storing data” displays for a
few seconds. When completed, the parameter values will then be in the EEPROM,

used in the next powerup of the inverter.
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Quick Menu Edit Some Quick Menu selections write data to the inverter’s EEPROM, usually
Permissions requiring the inverter to be in Stop Mode. These Quick Menu selections are:

» Read/Write Menu, Write EEPROM Data operation (edit permission required for
all inverters)

» Store to EEPROM (only SJ100/L100 inverters must be in Stop Mode)

Note that these operations do not rely on the Software Lock Mode, [SFT] intelligent
input, or related conditions. This is because the inverter’s RAM, which contains
working parameters while running, is not affected in an EEPROM write operation.

SJ300/L300P and SJ100/L100 inverters

WEITIMG
Inverter in THYERTERE STATE

Stop Mode

EEﬁDI%EELE MEHLI ///////'
. Rz
> Read EEPROM Dato
Write EEFEOM Dotn (display for 5 seconds)
\;;;;F\* STOF MOTOR EBEFORE

Run Mode WRITIMG EEFROM DATH
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SJ100/L100 inverters only

CIJTCK MEHL
B, BHz
ore o EEPROM

Inverter in

/ﬁjﬁfﬁiv torine dato
CUTCE MERML
H.AH=z STORE
Staore to EEFPROM ENTER
[Erter]

m GUICK MEHU

B EHz
Fun Mode Store o EEPREOM
tor motor firstl
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Quick Menu
Standard Items

Configuring the
Quick Menu

The remaining Quick Menu items represent a subset of the inverter’s parameters.
For example, the second (default) item in the Quick Menu is shown in the display.
Changing a parameter value in the Quick Menu is easy — the procedure is the same
as the one in Program Mode (described previously in this chapter). Just use the
Change Data key, Store/Enter key, and Esc/Cancel key as before.

Scroll up @ RUICK _MEMU
and down 8. 8H=

Quick Menu @ ARl Frea Set Method

EM
You can select which items are on the Quick Menu list. This feature is useful for
particular market segments or applications, or any time you know in advance which
parameters will be edited most often. To configure the Quick Menu in the SC-OPE,
you will need the Configuration Kit, SC-OPE-3CK. Install the Configuration Editor
as described in Chapter 2.

To configure the Quick Menu:

1 Connect the configuration cable from the SC-OPE’s front network (RS-232) port
to a Comm port on the PC.

2 From the Windows desktop, click Start > Programs > Hitachi > SC-OPE 3 Editor.

Note: If necessary, configure the Configuration Editor s COM port settings to match
the port used to connect to the SC-OPE. (Click Editor > Set COM Port Option).

3 Click Transfer > Upload Configuration.

4 Place the SC-OPE in Config Transfer Mode by holding down the Mode key for 4
seconds.
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5 Ifthe SC-OPE is ready, refer back to the PC and in the Set Up Upload dialog box,
click OK.

6 When the Information dialog box indicates Upload Complete, click OK. The
untitled SC-OPE Configuration just uploaded will appear in a window in the Con-
figuration Editor.

7 In the Quick Menu Configuration group,
click the Setup button. The Configure Quick

% Configure Quick Menu !E

. . Add Insert Delete Edit
Menu dialog box will appear as shown. The | | | |
. . . Murn Cuick Menu lkem
list of parameters is the current Quick Menu 1 00T Freq et Me
in the SC-OPE. 2
3 ADD3 Base Frequency
. . 4 A0D4 Max Frequency
8 You can make edits by using the buttons 5 A041 Torg Boost Sel
. B A042 Man Torg Boost
at the top of the Configure Quick Menu 7 £044 T3t Ctl Method
: 8 ADBZ Motor Walkage
dialog box. 5 HOD4 st Mir Pol Sel
10 FOO2 1t Accel Time
+ Add - Click Add to add a new item to 1 FO03 1t Decel Time
. 12 BO0E Open-Phasze Sel
the bottom of the menu list. Select the 13 BO12 E-Therm Level
f h d 14 B0 Stop Mode Sel
parameter from the pop-up menu an 15 D005 Irp. Terminals
click OK 16 DO0E Out. Teminals
: 17 Trip Histary
¢ Insert — Click Insert to insert a new | |
. . . Default Ok Cancel
item just above the currently selected item Ly
in the menu list. Select the parameter

from the pop-up menu and click OK.

* Delete — Click Delete to delete the currently selected item in the menu list.
Then click OK.

« Edit — Click Edit to replace the currently selected item in the menu list. Select
the new parameter from the pop-up menu and click OK.

* Default — Click Default to restore the factory default list.

» Cancel — Click Cancel to discard edit(s) to the Quick Menu Configuration in
the Editor.

* OK - Click OK to accept the changes to the Quick Menu Configuration.
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To download the new Quick Menu to the SC-OPE:

1 From the Configuration Editor’s main menu, click Transfer >
Download Configuration.

2 Confirm the communications cable is connected.

3 Confirm the SC-OPE is in Config Transfer Mode, or restore that mode by
pressing the Mode key for 4 seconds.

4 In the Setup Download dialog box, click OK.

5 In the Information dialog box, click OK.

Inverter Operation
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Copying Parameters Between Inverters

The SC-OPE provides a “copy unit” function — you can copy one inverter’s param-

eters into another inverter. This capability is often needed in OEM situations. A
copy operation consists of two parts:

1. Read one inverter’s parameters into the SC-OPE’s EEPROM.

2. Write the parameters stored in the SC-OPE to the second inverter’s EEPROM.

A Caution: Be sure to power OFF each inverter before connecting / disconnecting the
SC-OPE. Otherwise, damage to the inverter or SC-OPE may occur.

Note: The steps in the following example use a cable to connect the SC-OPE to the
inverter. You could install the SC-OPE in each inverter s keypad bay instead.

To perform a copy operation:

1 Connect the SC-OPE to the inverter Source Destination
which contains the parameter settings \
you want to use as the source. = =
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2 Press the Read/Write

Menu key to access the Read/ FEADMMRITE HMEHU

Write Menu as shown. READ ..
Fead EEFREOM Dotao

Note: You can use the Up and # MWrite EEPROM Dota

Down Arrow keys to select
either the read or write oper-
ation.
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3 With the read operation

selected, press Store/Enter to STORE RECTIHG
perform the Read EEPROM ENTER IHVYERTER STETE
Data. After a few seconds the

SC-OPE displays the confir-
mation message as shown.

_IHVERTER STATE
STORED IM MEMORY
(automatic)
4 Press the Esc/Cancel key to . — l )
: B, EA H. 8% @08kl
return to the default Mor.utor ESC GG A Bk
Mode (or press the Monitor CANCEL | | Furn:0OFESFra:0FE
Mode key). Morm Stor § Met Cirl
5 Power OFF the inverter Source Destination
and disconnect the SC-OPE.
|| |

6 Connect the SC-OPE to the desti-
nation inverter of the parameter set.

7 Power ON the inverter. J H J

Note: Do not run the motor; the

inverter cannot update all of its
parameters while it is in Run Mode.

8 Press the Read/Write Menu key to access
the Read/Write operations as shown.

FEADVWREITE MEML

F Reod EEFROM Doto
Write EEPEOM Tota

9 Press the Down Arrow key to select
Write EEPROM Data.

10 Press the Store/Enter key. The “Writing Inverter State” message will display for
a few seconds.

The copy operation is complete! You have copied one inverter’s entire parameter set
to another inverter. Those parameters are still in the SC-OPE’s EEPROM, so you
can connect the SC-OPE to other (destination) inverters to update their parameters
in the same way.
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Monitor Mode

Orientation

Inverter Variable
Monitoring

The SC-OPE’s Monitor Mode is designed for operators to monitor important
inverter data and control status during normal, day-to-day operations. Equipment
operators and technicians will typically leave the SC-OPE in monitor mode at all
times until the need to change a parameter value arises.

The screen layout in Monitor Mode consists of dedicated text field locations as
shown below. The upper two lines display inverter variables. The field locations
have reference numbers so you can configure which inverter variable is displayed in
each field. The third line displays the current source of the Run Command and the
main Frequency Setting. The fourth line displays the inverter status and the current
control source for the SC-OPE (keypad or network connection). The Monitor Mode
screen below shows the inverter in a normal stop condition.

Inverter monitor parameters

| Variable 1.1 Variable 2 !

Variable 1.2 Variable 1.3

Cc
\ l _/ 5@
<5
b ¥ ¥ o@
_____ B.EY  G.E% 6,66k &5
MONITOR B, BHz < am
Fur:OPE/Fra: Wi < 3%
Morm Stor f Eea Chrld 23
4 » J % 8
/ A\ 35

Run command Inverter status Control source Frequency

source setting source

In addition to displaying the values, you may occasionally need to refer to the vari-
able names. For example, a reading of “0.0%” could refer to torque or current.

Press the Monitor Mode key

to view the names of the vari- Ciﬁﬁl"'lc""'t = HI:EIT- E i
ables in positions 1.1, 1.2, MONITOR FLIF :EHE'!::.FF;:*L: W
and 1.3 (display line 1). | Morm Stor § Kewa Cirld

Press the Monitor Mode key _
again to view the name of the Q.»Tzi"" rent Fredusncd )

] K. HH=
variable in position 2 (display | MONITOR Fum: OPE/Fras W
line 2). Press the Monitor - Morm Stor 0 Kewo Cirl

Mode key once more to
return to the initial display.




3-28

Using the Keypad for Inverter Operation

When the source of Frequency Setting is the Operator Keypad (OPE), the second
line becomes dedicated to displaying the set frequency and actual frequency (pre-
configured variable 2 output is suppressed). This feature is useful to help machine
operators avoid severe frequency over-shoot / undershoot when the set acceleration
and deceleration rates are relatively low.

Desired Actual
output frequency output frequency

.8y H. 8% 8,08k
H.6 H.060H <

Fun: OFEMFrasOFE <

Horm Stor § Eea Cirl

-

Frequency source is Operator Keypad
(OPE)... forcing the display of desired
and actual output frequencies

Program Mode provides access to change the four variables you can display on the
upper two display lines. The figure below shows the location of the “Monitor Vars”
submenu within the menu list in Program Mode.

* Program Mode « Monitor Vars —»— Var 1.1
. * Var1.2
PROGRAM : * Var13
—
I

Inverter Operation
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. * Var2

]
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To configure the Monitor Vars:

1 Press the Program Mode key. Monitor Vars is at the top of the Program Mode
menu list (normally displayed first unless a prior Program Mode session is active.)

2 Press the Up and Down Arrow Keys if necessary to access the Monitor Vars item.

3 Press the Right Arrow key to enter the
Monitor Vars sub-menu. The example
display to the right shows that the current
setting for Var 1.1 is “Output Current (A).”

PROGRAM MODE
g, BHz

VaR 1.1

Outeut Current OFD

4 Use the Down Arrow key to scroll to the
other Monitor Vars items, if necessary.

5 Press the Change Data key to change a
particular Monitor Var. The “>” and “<” T
characters indicate Change Data is active. VER 1,

FOutrut Moltose oW

FREOGFEAM MOTE

6 Use the Up Arrow and Down Arrow

c
keys to scroll through the list of available :<T 2
variables. Stop at the desired variable such ga
as “Output Voltage (V).” % 3
~
T D
7 Press Store/Enter to accept the new g S
Monitor Var. To abort the Change Data 5 g
operation, press the Esc/Cancel key. °3
8 When you press the Monitor key, the Output voltage (V)
new Monitor Variable will display in the I

corresponding field. BLEY BB B, Bk
i B, G B, BEHz
FuriOFESFra:0PE

Morm Stor § Kew Chrl

Note: The Monitor Vars configuration is part of a SC-OPE configuration. The
SC-OPE Configuration Editor on the PC does not show Monitor Vars status — you
must use the Program Mode on the SC-OPE to configure Monitor Vars.
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Hand/Auto Key
Operation

Monitor Mode is the central mode for operator-based control of the inverter, and it
shows the current status of the user-selectable inverter control sources:

* Run Command Source — set by parameter A002

* Frequency Setting Source — set by parameter A001

The Hand/Auto key serves the purpose of
letting the operator scroll through and set
applicable combinations of the above Rur: |:|F'f:_-." Fra:0OFE )
source selections. Each press of the Hand/ Horm Y:it- oF § O Kew Cirl
Auto key increments to the next combina-

tion of Run Command Source / Freq. \> Hand/Auto setting
Setting Source. The current settings are

displayed on the third line of the display
as shown. The table below shows the available combinations inverter settings.

B . B0 BB B, BEkb

Hand/ Run Command Source Freq. Command Source
Auto
Select | Display A002 Value Display A001 Value
1 OFE | 02 = Operator OFE 02 = Operator keypad (REM)
keypad (REM)
2 W 00 = Keypad potentiometer (VR)
3 TEPM | 01 = Control terminal (TRM)
4 TEM | 01 = Control ter- TEM 01 = Control terminal (TRM)
minals (TRM)
5 W 00 = Keypad potentiometer (VR)
6 OFE 02 = Operator keypad (REM)

When the SC-OPE is in another normal mode (such as Program Mode or Quick
Menu), a press of the Hand/Auto key will automatically switch to Monitor Mode
and increment the Hand/Auto setting.

Note: Any Hand/Auto setting change immediately changes parameters A001 and
A002 in the inverter. However, you must perform a Store to EEPROM operation
(available in the Quick Menu) to store the change to retentive memory.

Note: Control of the inverter via a network connection to the SC-OPE requires that
you use the Hand/Auto setting Run:OPE / Frq:OPE. This will permit the SC-OPE to
send network command values to A002 and A001 inverter parameters, respectively.




.
Monitor Mode

Monitor Mode As discussed in the Program Mode section (see page 3—14), the SC-OPE monitors

Edit Permissions the inverter’s Software Lock Mode setting, Run/Stop Mode status, [SFT] intelligent
input status, etc. This enables the SC-OPE to allow or prevent the editing of inverter
parameters, as appropriate for each parameter in real time. Although Program Mode
is the obvious method to edit parameter values, Monitor Mode also provides edit
capability for specific parameters as shown below. The section “Motor Control
from the SC-OPE” on page 3-8 introduced the Monitor Mode display of these
parameters and how to edit or change them.

B.Ex 8. BEk

FO01 Output Frequency Setting o Bk
A, FEIHE

A002 Run Command Source

A001 Freq. Command Source

Output Frequency Editing The

Change Data key provides access to edit | bR 8.6 6. Ak

. i, Bl i, EiHz

the Output Frequency Setting (F001), R rlF EfFra:0FE
and the “< >” edit cursors appear. Then Horm Stor f Kew Ctrl _c
the Up/Down Arrow keys will immedi- c:<; a
ately increment/decrement the fre- CHANGE T=
quency value with each key press. If the DATA 5 ;
status of the Software Lock Mode or - B

. . (displayed for 5 seconds) 39
other conditions prevent editing the = 2
output frequency at any point, pressing lEir_'lEIE_E'ji EHHTT”HLLijD i)
the Change Data key or Up/Down T el

i [SFTI =1 IFF s of
Arrow keys will cause the SC-OPE to BEAZSI=0]1s 83 or 18

display the message shown to the right. -
Use the checklist to verify that condi-
tions allow parameter editing.

T H. 8y @, 8akh

Similarly, pressing the Hand/Auto key FI e IE:F ETFF - |é1E :'UH"’-
immediately updates the Run Command Horm Stop f |'=-1:E-*:l Chrl
Source (A002) and/or the Frequency \

Command Source (A001). If the status

of the Software Lock Mode or other

conditions prevent the editing of these

parameters, pressing the Hand/Auto key (displayed for 5 seconds)
will cause the SC-OPE to display the Homciuto HOT SLLOWED
message shown to the right. Use the CHECE: Molor storred
checklist to verify that conditions allow :F”F_]I-_] E ;,:_:EFE”-

parameter editing.
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Restoring Factory Default Inverter Settings

The parameters in a new inverter will already match the default values applicable
for your country. However, you may eventually need to initialize an inverter’s
parameters just to establish a starting point for troubleshooting, etc. The initializa-
tion procedure will restore inverter parameters to their factory default values, clear
trip history information, or both. Parameter initialization makes use of a “country
code” setting (Japan, the U.S., or Europe) for slightly different parameter values.

Note: This initialization procedure applies only to SJ300 and L300P inverters.
Initializing SJ100 / L100 inverters requires disconnecting the SC-OPE and using
the inverter's keypad. The J300 inverters require an input signal on terminal STN.
Follow the initialization procedure in each inverter's instruction manual.

The initialization functions are accessible in the Program Mode menu. The menu
organization of these menu items is shown below.

“Initial” sub-menu

* Program .

o Mode p . s

O « Parameters —p—— |nitial —®»—— Initialize Mode
]

_c'é_ﬁ * . + Country Code
5 PROGRAM

23 — . + Reinitialize Drive

Ve I

() OL.) —* —- —

s2 I . [ [

20 I | I

‘mn £ ! . L—o —o

-}

To initialize inverter parameters:

1 Press the Program Mode key, and navigate to the “Initial” submenu (see Program
Mode menu map above).

2 Verify the options for Initialize Mode are as
you require. If necessary, press the Change Data
key, scroll to the desired setting listed below, and
press the Store/Enter key.

Initialization Options:
 Trip history only

» Both trip history and
inverter parameter data

3 Press the Down Arrow key to scroll down to * Inverter parameter only
the Reintialize Drive menu item.

4 Press the Right Arrow key to get the
display as shown.

FROGRAM MODE
. BHz
EHTER=wez / ESC=ro

5 Press Store/Enter to initialize, or
Esc/Cancel to abort.




Using Networks
for Inverter

Operation

In This Chapter. . .. page
» Setting Up a Network Interface .. ................ 2
* Connecting to a ModBus RTU Network . . . ......... 18
* Connecting to a DirectNet Network . .............. 23

Connecting to an Allen-Bradley DF1 Network . . ... .. 28



Using Networks for Inverter Operation

for Inverter Operation

(2]
x
—
o
2
)
P4
>
—_
]
2
3]
©
(T
o
£
n
2

Setting Up a Network Interface

Introduction

In addition to providing a full-featured operator interface, the SC-OPE 3H provides
a factory network interface function. Using a factory network allows a host com-
puter or controller to command multiple inverters on a single network. Each inverter
will have its own address (or station number) on the network (except for Allen-
Bradley DF1). The protocol you will need to use is determined by the requirements
of the master controller (or host) on the factory network. The SC-OPE is config-
urable to use one of the following networks:

Protocol Inverter Address Range Default Address

DirectNet 1to 90 1

Allen-Bradley DF1 — —

ModBus RTU 1to 255 1
ModBus ASCII 1to 255 1
Metasys N2 1to 255 2

Network Port Mode (Electrical) Selection The electrical characteristics of your
factory network will be selected independently of the protocol selection. Factors
which determine the proper electrical mode include the network length, number of
inverters on the network, and the serial port electrical characteristics of the network
master computer. In simplex operation, the same wires are used alternately for
transmitting and receiving. Half duplex operation uses separate transmit and receive
wiring, but only one half (TX or RX) will be in operation at a time. Note that while
some protocols support up to 255 node addresses (address of each device), RS-485
networks are limited to a maximum of 32 devices.

The following table lists the SC-OPE serial port modes and the typical application
for each one:

Application

Communications Network Port

Mode i Connector

Distance Devices SRy
Duplex

RS-232 Upto15m 2 only Half duplex Front (RJ11)
RS-485 2-wire Up to 100 m Up to 32 Simplex Bottom (10-pin)
RS-485 4-wire Up to 100 m Up to 32 Half duplex Bottom (10-pin)
RS-422 4-wire Up to 100 m Upto 2 Half duplex Bottom (10-pin)
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RS-232 The RS-232 Port is accessible on the front panel of the SC-OPE as shown below. Its

Serial Port most common use is for connecting to a PC for OEM configuration tasks. However,

Wiring Diagrams the serial port can respond to network commands, with the proper SC-OPE configu-
ration). The cable included in the Configuration Kit has a 4-wire RJ11 connector,
using the 4-wire subset. You can also make a custom cable (using the 6-wire set or
the 4-wire subset) and connect the SC-OPE to a PC or host computer.

Network Port,
RS-232 Connector

4-wire 6-wire set
subset RTS _1
GND-2 (" GND_2 .
X 3 ™ 3
Rx 4| rRx 4
GNDS_ | GNDS
cTs_6

A typical RS-232 network port connection is between a PC and the SC-OPE only.

Host computer Inverter

Serial cable

Connection details

RX 2 4 RX
™x 3 3 TX
GND 3 5 GND

9-pin D-shell

c
o .
=3
?(D
3o
T
=9
O"<
o

®F
=
5 2
o

=
w

6-pin modular RJ11

An RS-232 connection provides an easy way to connect two devices. Since the con-
nection is limited to only two devices, RS-232 type communications is not a part of
the 2-wire network discussion.
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Network Wiring
Configurations

Guidelines to configure a RS-232 connection:

* The port of the device you connect to the SC-OPE must also be RS-232 type.
* The TX line of one device connects to the RX line of the other device.

* Remember to make the ground connection between the two ports.

» The wiring distance will be limited to 50 feet at 19.2k baud.

Note: When using a factory network protocol, you can use the front panel network
port for the connection. However, RS-232 signal levels limit the network to a point-
to-point connection (SC-OPE and one other device). If your network requires more
than two devices, use the RS-485 network port described on the following page.
Alternatively, you can use the RS-232 port with an external RS-485 converter.

The RS-422/485 port is accessible on the 10-pin connector at
the bottom of the SC-OPE assembly as shown below. The con- ]
nector for use in making a matching cable is included in the

Bezel Kit. The connector provides individual retention of wires,
facilitating daisy-chain network topologies which are typical in
factory networks with multiple inverters. = =

In a factory network with multiple inverters and/or end-to-end RS-422/485
lengths of more than 15 meters (45 ft.), we recommend using Network Port
the RS-422 / 485 network port. Networks with three or more

devices will require using the RS-485 mode. Each SC-OPE

must be configured with a unique network address (described

later in this section).

Host computer Inverters...

Addr = 00

Factory network
or building network
Addr = 01 Addr = 02 Addr = 255
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Some factory networks originate in programmable logic controllers (PLCs). The
CPU or network interface module in the base (as shown below) will provide the

interface.
PLC with 1/O base Inverters...
N \
m ] ]
T [
Pt |
U (w

SC-OPEs...

Network interface
module

Factory network
or building network

Addr = 00 Addr = 01 Addr=02 Addr =255

RS-422/485 The SC-OPE’s RS-422/485 port can connect

Serial Port to 2-wire or 4-wire networks as listed to the RS".‘22/4{.35 212 ]
configurations:

Wiring Diagrams right. The figure below shows the port’s
connections. The power connections are
typically unused, as the SC-OPE is powered

* RS-485 2-wire
* RS-485 4-wire

by the inverter. For instructions on config- = * RS-422 4-wire o o
uring the SC-OPE network ports, refer to I—
page 2-26. ol S
s 5
SQ
Network Port, RS-422/485 Connector é ;',"
=1
CD —
Power Connections Serial Port Connections 55
G\D 10 T Tx+ ?F
3%
vee 9 2 1x- =3
8 3 GND 3
(reserved 7 4 Rx+
6 | 5 Rx-

End view of SC-OPE
bottom edge I

10987654321

LILLIIIL]
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You will need to decide whether your network will be a 4-wire or 2-wire type. If
any device on the network is a two-wire device (or otherwise has combined TX/RX
lines), then the network must be a 2-wire type.

Guidelines to configure a 4-wire network:

 Configure the host computer or controller as the network master. The SC-OPE(s)
on the network are the slave(s).

* Remember to configure the SC-OPE network port (refer to page 2-26).

* The master’s TX and RX lines connect to the RX and TX lines on the slave(s)
respectively. In other words, they cross: TX+ (master) connects to RX+ (slaves),
and TX- (master) connects to RX— (slaves).

» Each device on the network must have a unique address.

* If you have more than one slave device, wire all of them (as a group) in parallel.
* Remember to make the ground connection between all ports on the network.

* Add network termination resistors (see page 4-8).

» Limit the total number of devices to 32 for RS-485.

Host Computer SC-OPE Otherslave
(network master) devices
£c rT,raﬂsfeD' e RS-485 4-wire network
o8 ! | TX+ A TX+
E _,é ‘ | T L ® TX+
Sg | ™ e 1™
gg ‘ : RX+ : : RX+ ® RX+
S 10:.) I I RX— ' RX- & RX-
L2 ‘ | GND Ny GND
g ‘L ! ‘e ° ® GND
=gy
2 L

Guidelines to configure a 2-wire network:

 Configure the host computer or controller as the network master. The SC-OPE(s)
on the network are the slave(s).

* Remember to configure the SC-OPE network port for 2-wire operation
(refer to page 2-26).

(continued, next page...)
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* The network master device or other devices on the network may also need firm-
ware configuration to 2-wire operation. In this way, each device on the network will
not attempt to transmit and receive at the same time (would cause a comm error).

» Connect only the TX+ and TX- lines of the SC-OPE to the network: That is,
connect its TX+ to TX/RX+, connect its TX— to TX/RX-. This works only because
the SC-OPE automatically connects transmit and receive circuits to the two lines.

» For wiring instructions of other network devices, refer to the respective product
documentation from the manufacturer. But in general, we can say:

* If the device has two wires (typically labeled TX/RX+ and TX/RX-), these
connect directly to the network.

« If the device has four wires, you may need to jumper its transmitter/receiver
lines together. Jumper TX+ to RX+, and jumper TX— to RX—.

* All devices’ TX/RX+ lines and TX/RX- lines connect in parallel.
* Remember to make the ground connection between all ports on the network.

* Add network termination resistors (see page 4-8). Note that the device at each
end of the network will only have one termination resistor.

* Limit the total number of devices to 32 for RS-485, 2 for RS-422.

» Each device on the network must have a unique address.

The diagram below shows a 2-wire network. In this example, the host computer has oy <
a 4-wire port that has been jumpered for 2-wire operation. Sometimes a host com- ;_‘8
puter will have internal jumpers or firmware settings that have the same effect as the s
jumpers shown. However they are configured, only two wires (plus GND) will c_% %
connect one device to another. o<
o Z
)
o=
Host Computer SC-OPE Otherslave o8
(network master) devices 5
. RS-422/485
Transceiver :
- - A 2-wire network
! PN PRRS TX/RX+
| | \
TX= / o TX/RX-
| \ / @
‘ RX — GND
I [ ]
| RX~
| [ ]
| 1 GND
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Network
Termination

Termination Resistors When wiring a factory network it is important to consider
the reliability and noise immunity of network communications. Differential trans-
ceivers provide general noise immunity. However, factors which degrade noise
immunity include longer total network lengths, noisy environments, and a large
number of devices on the network. The Network Termination Board (included in
the Bezel Kit) contains network termination resistors. These resistors connect
across TX+ / TX— and RX+ / RX- at the physical end of the wiring pairs as shown

in the figure below.

Host Computer

SC-OPE Otherslave
(network master) devices
Termination
resistor
Transceiver M

P oo - 1200

| Xt >+

\ X ® TX—

! RX+ RX+

|

| RX- r—/. RX—

\

| GND

| ® GND 120Q ®
Bias Resistors A transceiver’s differential
signals are in a tri-state condition (floating, "Ige;‘\’l‘:g;k
with respect to GND) between transmissions. Vee 1kQ
This can make a network more susceptible to L 4
noise particularly with higher baud rates. The
maximum speed of SC-OPE communications T+
is 19.2 k Baud, still low enough for reliable 1 ™
communications in many applications. The 1 Rxr
Network Termination Board contains bias | *—
resistors. These include 1kQ pull-up and pull- ®
down resistors at each node.

® GND
1kQ
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Connecting a The Network Termination board contains termination and bias resistors. This board

Network Termi-  is a component in the Bezel Kit. Your network will need termination at the device

nation Board on each physical end of the cabling. A wiring procedure is on the following page.
r— 10987654321 —

LTI II]]]

Network Port, RS-422/485 Connector
SC-OPE Bezel/

Housing Assembly

oo s765432 1] (keypad facing

Connector Plug

(terminal screws L ﬂjJ down)
facing down)
R - IL |-
\@ 600 0|
| RX= J_
Network Termination Vce RX+ I
Board : GNDT)<—
(component side — TX+
facing up) ‘® oo o ®|TB1
o o B |T|
[ TX+
TX=
GND
RX+
RX—

To install a Network Termination Board:

1 Mount the SC-OPE 3H in the bezel/housing and secure the SC-OPE assembly as
outlined in Chapter 2, Installation.
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2 Ensure the SC-OPE location will be at one physical end of the network cabling.

3 Locate the Connector Plug and Network Termination Board in the Bezel kit.
Refer to the wiring diagram on the previous page. Use wires approximately 2” long
to connect the Network Termination Board TB 2 connector to the Connector Plug.
Take care to orient the two components as shown (board is component side up, con-
nector block is screw terminal side down).

(continued, next page...)
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4 Plug the assembly into the network connector at the bottom of the SC-OPE.
5 Attach the network wiring to the Network Termination Board.

Note: A host computer or another device besides the SC-OPE may be at one end of
some networks. In this case, please refer to the device manufacturer s instructions
regarding network termination. Some devices have internal termination resistors
that may be connected/disconnected with jumpers.

Tip: If needed, you can use a Network Termination Board as termination for a
device other than a SC-OPE. First, be sure that device does not already have built-
in termination resistors.
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Setting Up a Network Interface

Configuring
Network Control
of Inverter

0y

Network Control Setting The SC-OPE

configuration contains the Control Method | .,

Setting which determines whether the e |
SC-OPE keypad or the factory network Horm
commands received are in control of the

inverter. Use Monitor Mode to view the current setting as shown. After you have
connected a network host to the SC-OPE and you are ready to try network control,
it will be necessary to change the Control Method Setting to “Network” (Net Ctrl).
See “Selecting Keypad or Network Control” on page 3—4.

Inverter

Network Host SC-OPE
Computer

Keypad

Factory Network E ‘Ld\e
or
|
! -
|
|

building network Network Port |—O

Control Method
Setting

Hand/Auto Setting When receiving and interpreting network write commands, the
SC-OPE will command the inverter as if an operator were using the SC-OPE (from
the inverter’s point of view). If the inverter is configured for control via its own
keypad or input terminal, it will ignore network commands sent via the SC-OPE.
So, controlling the inverter from a network requires that you set the following:

* A002 Run Command Source = 02 (Operator keypad — REM) = Run:OPE

* A001 Frequency Setting Source = 02 (Operator keypad — REM) = Frq:OPE

If either source setting is set for control terminal operation, Run:TRM or Frq: TRM,
the corresponding control from the network will not be possible. It is desirable, for
some applications, to split the control source. For example, you may want network
control of Run/Stop functions, and use control terminals for the frequency setting
input — Run:OPE/Frq:TRM.
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Tip: To automatically set A002 and A001
as required for network control, simple
press the Hand/Auto key to select “OPE”
as the Run Command and Frequency o m Y:i'l:- oF f Rew Cirl
Setting sources as shown. More informa-

tion on Hand/Auto operation is on \\ Hand/Auto setting

page 3-30.
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SC-OPE Network The SC-OPE 3H supports several factory network protocols. You must configure it

Configuration before connecting it to a particular factory network. The configuration may be
edited directly on the SC-OPE, or you may use the Configuration Editor on a PC
and download the configuration.

To configure a SC-OPE 3H for connecting to a DF1 factory network:

Press the keys shown in the sequence below.

1 Press the MODE rorfia T : Mo
Confis Transfer Mode
key for 4 seconds. Woitinma for FC...
_Press MODE kew for
Configuration menu.

Hold 4 seconds

2 Press the MODE

key again (briefly). Confisuration Menu

Irmerter Port Cfa

3 Press the Down . )
Arrow key once. Confisuwration Menu

Hetwork Fort Cfa

B

4 Press the Right

Arrow key. Confiaurotion Memu

varem]

Hetwork Protoco
ModBu= BETU

5 Press the Change

Data key and use the CHANGE 4ii}k Confiaurotion Memu
Up Arrow key to DATA Hetuork Frotocol
select the desired pro- shirectietd

tocol from the list.
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6 Press the Store/

Enter key to store the Confisuwration Menu
STORE
change (or Esc/Cancel ENTER Metwork Protoco

to exit without DirectHet

changing).




Setting Up a Network Interface

7 Press the Down Arrow key to access the other network configuration parameters.
to edit a parameter, use the Change Data key, the Arrow keys, and the Store/Enter
key as in Step 5 and Step 6 above.

The complete Network Configuration submenu is shown below.

e Configuration __ + Inverter Port Cfg
Menu

* Network Port Cfg ——— + Network Protocol
— + Network Address
— < Network Port Type
— + Baud Rate

— + Data Bits

—— e« Parity

— e« Stop Bits

— <+ Flow Control

— + RTS Delay

— ¢ Mode (Master/Slave)
— ¢+ Max Gap Time

L « Stop Key Action

L < Store Configuration

Note: When editing the network node . -
Confisuration Menu

address, be sure to assign a unique =<

, . ) ge

number for each device on the network. |-._|:=-_,-t_ work Adodress =3

o <m

2 g

®3

. o<

8 In the Network Port type setting, be sure . - 3Z

your configuration matches the physical Confiauration Metw ]

network connection that will exist on the Hetuork Port Tare S 2
SC-OPE. FS485 4-lire

9 The Stop Key Action item (at bottom of
list) selects whether the Stop/Reset key on
the SC-OPE will be disabled (no action) or Stor Kew fotion
enabled (disables network control when Mo Action
pressed and returns control to the keypad).
The proper setting depends on your partic-
ular application.

Confiauration Memu
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10A fter making all the
Change Data / Store
changes to the

network settings,

press the Left Arrow

key to exit the

Network Settings submenu.

11 Press the Down
Arrow key to scroll
down to the Store
Configuration menu
item.

12 Press the Store/
Enter key to store the
configuration in the
SC-OPE.

13 Press the Down
Arrow key twice to
access the Monitor
Mode menu item.

14Press the Store/
Enter key to cause the
SC-OPE to reset and
enter Monitor Mode.

&

e

STORE
ENTER

]

Press twice

ENTER

wn
-
o
A
m

Confiaurotion Memu

Hetuork Port Cfa

Confiaurotion Memu

Store Confisuration
[Enter?

Confisuwration Menu

Store Confisuration
Confiauration Storec

Confiauration Memu

Mornd tor Mode
1Enter]
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Limiting the
Direction of
Rotation

A

The SC-OPE 3H keypad automatically limits motor rotation to one direction for
operator-initiated operation. Intelligent terminal configuration can also limit rota-
tion for external inputs. However, a SC-OPE and inverter under network control
may could respond to either a Run FWD or Run REV command. If Before you use
the SC-OPE the first time in any application, it is very important to consider any
motion restrictions the load may place on the motor.

Caution: The SC-OPE 3H can respond to FWD Run and REV Run commands
which are equally accessible via network commands. However, some machines are
designed for rotation in only one direction — and may be damaged if run in the
opposite direction. If you have such an application, you must follow the instructions
in this section to protect against accidental reverse rotation.

When a machine can run in only one direction, it is usually desirable to arbitrarily
assign that direction as “forward,” whether the actual rotation is clockwise or
counter-clockwise. You can change the direction of rotation associated with a Run
FWD command by swapping any two of the three wires going from the inverter to
the motor.

Warning: Be sure to power OFF the inverter for five minutes before opening the
power terminal access panel. Otherwise, the danger of electric shock exists.

The procedure in this section shows how to disable either one of the Run commands
(typically Run REV).

To restrict the Run commands to FWD only or REV only:

1 Press the Program Mode
key to enter Program Mode.

FROGESM MEMU
B BH=

PROGRAM itor Mars

2 Press the Down Arrow key FROGREM MEMLU
FLIAREH -

to reach the Parameters menu o
item. Fameters
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3 Press the Right Arrow key
to enter the Parameters sub-
menu list.

4 Press the Down Arrow key
several times until you reach
the Protection menu item.

5 Press the Right Arrow key
to enter the Protection sub-
menu list.

6 Press the Down Arrow key
several times to access the
Other menu item.

7 Press the Right Arrow key
to enter the Other sub-menu.
The first item is the Direction
Restriction parameter.

8 Press the Change Data key
to enable the Change Data
function.

9 Use the Up Arrow and
Down Arrow keys to scroll
through the available set-
tings: Free, REV, FWD. Most
applications will be set to
“REV” to disable the Run
REV command.

<3 KDV

N/

o
=
>
=
(7]
m

FREOGEAM MEMLU
8. GHz

I '|_:_i.‘|:-il:l.1

FREOGEAM MERLU
E, AHz
Frotection

FROGRAM MEHU
. BHz
E-Thermal

FREOGFEAM MEHLU
6. BHz

FREOGREAM MEMLU
B BH=

BEES Dir. Restrict

FEE

FROGEAM MEHU
B BH=

BEES Dir. Festrict

+FREEX

‘ROGEAM MEMU
6. BHz

-
-

3 Dir. Restrict
i
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10 Press the Store/Enter key

to accept the entry. FREOGEAM MEMLU

STORE 8. 8-z _
ENTER HES Dir. Eestrict

REY

11Press the Monitor Mode
key. The display will prompt
you to save the change made MONITOR

Inverter Foromerers
howve besn chamsed.
Store to EEPEOMT
in Program Mode to the STORE & CAMCEL
inverter’s EEPROM. g

12 Press the Store/Enter key

to save the parameter change It T *E'r_- _ F aromerer
. . STORE howve beeh chansed.

to the inverter’s retentive ENTER Store o EEPROMT

memory (EEPROM). #k Storing Doto sk

13 The inverter will now

reflect the restriction setting. Run FWD — - -

If set to ‘REV” for example, E‘i II:%HFIEI . E-"ﬁlﬂﬁgﬂtu
the inverter will only respond Rure OFE fFra:OFE =
to the Run FWD command. RUNREVE | Horm Stor f Eew Ctrl

J

Note: The parameter F004 Motor Direction determines the which command (Run
FWD or Run REV) the inverter applies when using either the standard Hitachi
inverter keypad or the SC-OPE 3H. Changing the sense of direction for network
Run commands will require reversing the two of the three motor wires.
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Connecting to a ModBus RTU Network

Overview

Many PLCs are available with built-in ModBus communication protocol. The relay
ladder logic (RLL) example in this section uses an arbitrary set of input points,
internal relays, registers, etc. for a DirectLogic PLC as a typical example. There-
fore, it is not intended for use as-is in an actual application.

When using network control of the inverter, the SC-OPE maps (translates) network
commands to specific inverter parameters. When writing your host computer
control program, you will need a map of network registers and inverter parameters.
Please refer to Appendix D and Appendix E for network register maps.

Warning: Be sure to set up the basic drive parameters before connecting the PLC
to the drive and running it. Failure to do this could result in damage to the drive or
the equipment connected to the drive.

Note: Remember that the number format of the registers in the drive is decimal,
while the number format of the registers in your PLC may be in BCD/HEX. If you
are viewing the drive values in a data view window, be sure to select decimal as the
format for viewing. If you are writing values to the drive, be sure to change the
value to decimal.

The following block diagram of the PLC controller shows its input switch assign-
ment for the following example program and the resulting inverter command.

c H
P n N
p t
U u W
L
X0 —¥| Run (start motor)
X1 —»| Stop SC-OPE-to-inverter
X2 —¥»| Setspeed =15Hz |
X3 —¥»| Setspeed =30 Hz [ 9
X4 —¥| Set speed =45 Hz
X5 —»| Setspeed =60 Hz i X J
Discrete input wiring ModBus

Network
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Ladder Program
Example for
ModBus Comm.

Port 2 Error Port Error
SP117 C10
— | ( SET)

Port Error
SP116 CO C10 D
| |
[ /l/r /l/r K101
LD
] K12
LDA
02000
RX
] TA5
Cco
——( SET)
C5
L (out)
Port Error
SP116 CO c10 D
| |
[ 1T /l/il/ K101
LD
] K8
LDA
03000
WX
N TA4
COo

L (RST)

Special relay SP117 reports a
communication error between
the PLC and the SCOPE (for
example, broken cable, etc.)

The following rung moves values from the SC-OPE to PLC memory register V2000.

The LD box designates the
bottom port of the DirectLogic
CPU as master and specifies
address 1 as the slave
address. The last digit (“1) cor-
responds to the number of
SC-OPEs (devices) on the
network.

LD box specifies the amount of
data to be read in bytes. K12
specifies 12 bytes or 6 words.

LDA box specifies the destina-

tion of the values being read.

Read from TA5 (V5) in the RX
operation. The equivalent

MODBUS RTU address = 40006.

This rung writes values to the
SC-OPE. We are loading the
values from V3000 in the DL250
CPU and moving them into TA4
(V4). The equivalent MODBUS
address = 40005.
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The following rung helps to ensure the PLC is reading valid data. It utilizes the fact
that if either the comm port of the inverter, the SC-OPE’s inverter port, or the cable
between the SC-OPE and the drive has a fault (error), the only register that will not
fail communications to the PLC is the Run Status register. When a port error occurs
we will attempt to read this register. A read failure indicates the problem is between
the PLC and SC-OPE. In this event, increment a counter five times and, when the
counter is done, turn control relay C34 ON.

SP116 Cc10 LD
| |
[ [
Port Error K101
LD
] K2
LDA
02003
RX
TA10
Port Error Run Status
C10 V2003 K20
| | # | TMR
[ | [ TO
K50
Port Error
TO C10
| (
—| | { RST )

Attempt to read the Run Status
register when a port error or
communications error occurs.

Keep reading the run status reg-
ister until the comm error clears
between the SC-OPE and the
Drive. K20 is the value of the run
status register when there is an
error for SC-OPE-to-inverter
communications.

The following rung monitors communications for port errors after attempting to read

the run status register.

T0| CNT
l
C5 Comm error
— | counter
CTO
K5
Comm Error SC-OPE-to-
Counter PLC error
CTO C34
| (
— | (out)

If errors persist, then increment the
counter 5 times. When the counter
is done, turn control relay C34 ON
to record the error for SC-OPE-to-
PLC communications. Control
relay C5 turns ON once normal
communication is resumed to reset
the counter.
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LD

X1

— |

K1

ouT

Run Cmd write
V3000

€101
( PD)

C101
|

\

LD

X2

1

KO

ouT

Run Cmd write
V3000

c102
( PD)

C102
|

\

LD

X3

K1500

BIN

ouT

Preset freq write
V3001

C103

C103
|

( PD)

LD

K3000

BIN

ouT

Preset freq write
V3001

Start the inverter from input X0
by loading the constant K1into
V3000 (run command register) of
the SC-OPE (K1=FWD,
K2=REV).

NOTE: This example program uses separate Start and Stop switch inputs. How-
ever, it is possible to use the NOT state of X0 to load a zero into the run command
register and achieve both start and stop functions with one input switch.

Stop the inverter by loading KO
into V3000, the run command
register of the drive.

These next few rungs load dif-
ferent speeds into the Preset
Frequency register in the drive.
The speed reference resolution
is in 0.01 Hz, so a load of K1500
yields 15.00 Hz.

Set the inverter speed to 30 Hz.
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X4 €104 Set the inverter speed to 45 Hz.

C104 D
|
f K4500

BIN

ouT

Preset freq write
V3001

X5 C105

_| I ( PD ) Set the inverter speed to 60 Hz.

C105 LD
|
I K6000

BIN

ouT

Preset freq write
V3001

The following rungs implement diagnostic monitoring which you can access from the
run status register 40009. The status register consists of bit-level indicators of status
events. By viewing the register in binary, you will see that bit 7 is ON when the inverter
is running, bit 0 is ON when the inverter is stopped, bit 7 and bit 2 are ON when the

)
X c
g ) inverter is in deceleration. Consult the register map for a detailed explanation on the
Z 8 status register.
)
Z Qo
>0 V2003I | K1 p C20 Inverter stopped — 82 is the hex
2 E | = (out) equivalent of 130 in decimal
T 0
o z V2003 K82 C21 Inverter in deceleration — 83 is
gg | = | (out) the hex equivalent of 131
N Y
2 V2003 K83 c22 Inverter at preset frequency —
| = | (out) 84 is the hex equivalent of 132
V2003 K84 Cc23 Inverter in acceleration — 84 is
| =} (out) the hex equivalent of 132
V2003 K42 C24 Inverter in trip — 42 is the hex
| = | (out) equivalent of 66

—~

END ) End of program
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Connecting to a DirectNet Network

Overview

Some PLCs are available with built-in DirectNet communication protocol. The
relay ladder logic (RLL) example in this section uses an arbitrary set of input
points, internal relays, registers, etc. for a DirectLogic PLC as a typical example.
Therefore, it is not intended for use as-is in an actual application.

When using network control of the inverter, the SC-OPE maps (translates) network
commands to specific inverter parameters. When writing your host computer
control program, you will need a map of network registers and inverter parameters.
Please refer to Appendix D and Appendix E for network register maps.

Warning: Be sure to set up the basic drive parameters before connecting the PLC
to the drive and running it. Failure to do this could result in damage to the drive or
the equipment connected to the drive.

Note: Remember that the number format of the registers in the drive is decimal,
while the number format of the registers in your PLC may be in BCD/HEX. If you
are viewing the drive values in a data view window, be sure to select decimal as the
format for viewing. If you are writing values to the drive, be sure to change the
value to decimal.

The following block diagram of the PLC controller shows its input switch assign-
ment for the following example program and the resulting inverter command.

c { c
P n N 8‘ @,
p| |t -3
U |ul w 2
L g
X0 —¥| Run (start motor) 5
X1 —»| Stop SC-OPE-to-inverter -Q;
X2 —»| Setspeed =15 Hz u g %
X3 —»| Setspeed = 30 Hz = Ss
X4 —| Set speed = 45 Hz <
X5 —¥| Set speed = 60 Hz . . J
Discrete input wiring DirectNet

Network
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Ladder Program
Example for
DirectNet Comm.
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Port 2 Error Port Error
SP117 C10
— | ( SET)

Port Error
SP116 CO C10 D
| |
[ /l/r /l/r K101
LD
] K12
LDA
02005
RX
V2005
Cco
——( SET)
C5
L (out)
Port Error
SP116 CO c10 D
| |
[ 1T /l/il/ K101
LD
] K8
LDA
03004
WX
] v2004
COo

L (RST)

Special relay SP117 reports a
communication error between
the PLC and the SCOPE (for
example, broken cable, etc.)

The following rung moves values from the SC-OPE to PLC memory register V2000.

The LD box designates the
bottom port of the DirectLogic
CPU as master and specifies
address 1 as the slave
address. The last digit (“1) cor-
responds to the number of
SC-OPEs (devices) on the
network.

LD box specifies the amount of
data to be read in bytes. K12
specifies 12 bytes or 6 words.

LDA box specifies the destina-
tion of the values being read.

Read from V2005 in the RX
operation, the preset frequency
(according to the register map).

This rung writes values to the
SC-OPE. We are loading the
values from V3004 in the DL250
CPU and moving them into
V2004 in the inverter.
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The following rung helps to ensure the PLC is reading valid data. It utilizes the fact

SP116 Cc10 LD
|
' I K101
Port Error
LD
K2
LDA
02010
RX
V2010
Port Error Run Status
C10 V2010 K20
| | # | TMR
[ | [ TO
K50
Port Error
T0 Cc10
| (
—| | ( RST )

the run status register.

Tq CNT
l
C5 Comm error
— | counter
CTO
K5
Comm Error SC-OPE-to-
Counter PLC error
CTO C34
| (
— | (out)

that if either the comm port of the inverter, the SC-OPE’s inverter port, or the cable
between the SC-OPE and the drive has a fault (error), the only register that will not
fail communications to the PLC is the Run Status register. When a port error occurs
we will attempt to read this register. A read failure indicates the problem is between
the PLC and SC-OPE. In this event, increment a counter five times and, when the
counter is done, turn control relay C34 ON.

Attempt to read the Run Status
register when a port error or
communications error occurs.

Keep reading the run status reg-
ister until the comm error clears
between the SC-OPE and the
Drive. K20 is the value of the run
status register when there is an
error for SC-OPE-to-inverter
communications.

The following rung monitors communications for port errors after attempting to read

If errors persist, then increment the
counter 5 times. When the counter
is done, turn control relay C34 ON
to record the error for SC-OPE-to-
PLC communications. Control
relay C5 turns ON once normal
communication is resumed to reset
the counter.
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XOl y €100 Start the inverter from input X0
— | ( PD) by loading the constant K1into
V3004 (run command register) of
G100 LD the SC-OPE (K1=FWD,
' K1 K2=REV).
ouT

Run Cmd write
V3004

NOTE: This example program uses separate Start and Stop switch inputs. How-
ever, it is possible to use the NOT state of X0 to load a zero into the run command
register and achieve both start and stop functions with one input switch.

X1| , €101 Stop the inverter by loading KO
— | { PD ) into V3000, the run command
C10|1 5 register of the drive.
! KO
ouT
Run Cmd write
V3004
X2 C102 .
| ( PD ) These next few rungs load dif-
! ' ferent speeds into the Preset
c102 D Frequency register in the drive.
} The speed reference resolution
K1500 is in 0.01 Hz, so a load of K1500
ields 15.00 Hz.
g c BIN v “
c.L
:%
Qo
Z Qo
=0 ouT
S Preset freq write
85 V3005
=
oL
(=N X3 C103
‘B O Set the inverter speed to 30 Hz.
=ha — | ( PD) p
C10|3 LD
! K3000
BIN
ouT
Preset freq write
V3005
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X4 €104 Set the inverter speed to 45 Hz.

C104 D
|
f K4500

BIN

ouT

Preset freq write
V3005

X5 C105

_| I ( PD ) Set the inverter speed to 60 Hz.

C105 LD
|
' K6000

BIN

ouT

Preset freq write
V3005

The following rungs implement diagnostic monitoring which you can access from the
run status register 40009. The status register consists of bit-level indicators of status
events. By viewing the register in binary, you will see that bit 7 is ON when the inverter
is running, bit 0 is ON when the inverter is stopped, bit 7 and bit 2 are ON when the

[
-
. g . } . . o &
inverter is in deceleration. Consult the register map for a detailed explanation on the :8
status register. 25
[OR]
V2010I | K1 . C20 Inverter stopped — 82 is the hex c_% %
=1 (out) equivalent of 130 in decimal o<
T Z
V2010 K82 Cc21 Inverter in deceleration — 83 is g o
| = | (out) the hex equivalent of 131 = §
S =
V2010 K83 , C22 Inverter at preset frequency — &
1 = | (out) 84 is the hex equivalent of 132
V2010 K84 Cc23 Inverter in acceleration — 84 is
| = | (out) the hex equivalent of 132
V2010 K42 C24 Inverter in trip — 42 is the hex
| = | (out) equivalent of 66

—~

END ) End of program
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Connecting to an Allen-Bradley DF1 Network

The SC-OPE 3H includes the Allen-Bradley DF1 protocol. The SLC500 PLC
family PLCs feature this network connection option. You can connect multiple
inverters to a DF1 network, each inverter having its own network address. The
example in this section covers the network configuration settings of a SLC500 PLC.
RSLogix 500 is the programming software for the SLC500 family.

DF1 network configuration consists of these steps:
 Channel configuration
* Adding an MSG instruction for each network transaction in the ladder program

 Configuring the setup screen within each MSG instruction

Channel To configure the communications channel in a project:

Configuration ) o
1 In the RSLogix software, click File >

New to begin a new project.

2 Click File > Save As... to name the
project at this time.

GwHEes i

----- jjj 10 Configuration

—p Bl Channel Configurstion

2] Program Files

(2]

% S 3 Refer to the project element explorer —

% g pane to the left of the RSLogix window. In
ig- the Controller folder, double click the EI" E’E:p =
| . . -

% E Channel Configuration item as shown. Then 0] Contraller

SO the Channel Configuration dialog will | . i Cortroller Properties

o £ appear. e @ Processor Status

C o

55
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..... [ oo-output
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MSG Instruction

The remaining steps in this sequence refer to the Channel Configuration dialog

below.
Channel Configuration
General | Chan. 1-System Chan. - System |Chan 0-User |
B Source I
1 [decimal]
Baud
Parity
Protocol Control
Eontiol Line  [Na Handshaking x| ACK Timeout (+20 ms) [50
Errar D etection CRC = NaK Reties |3
Embedded Responses | Enabled = ENO Retries |3
¥ Duplicate Packet Detect
oK I Cancel I £oply Help

4 For the Driver setting, select “DF1 Full Duplex.”

5 Leave the Source ID setting at “1.”

6 In the Protocol Group, set the Control Line field to “No Handshaking.”
7 Set the Error Detection field to “CRC.”

8 Set the Embedded Responses field to “Enabled.”

9 Click (enable) the Duplicate Packet Detect check box.

The ladder program in your project will need an MSG instruction for each commu-
nications transaction with each inverter on the DF1 network.

To configure an MSG instruction for inverter communications:
1 In RSLogix, use the Input/Output instruction list to find the MSG instruction.

2 Insert the MSG instruction in your ladder

MSG
program. Remember to include logic to 4 Read/Write Message -
ensure the MSG instruction executes only Type Peer-To-Peer
when needed (and not on each scan) Read/Write Read -
’ Target Device PLCS
“ ’ Local/Remote Local
3 In the Type field, choose “Peer-to-Peer. Control Block N7-50
Control Block Length 14
Setup Screen
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4 In the Read/Write field, select “Read” to read data from the inverter, or “Write”
to write data to the inverter via the SC-OPE.

5 In the Target Device field, select “PLCS5.” The SC-OPE’s DF1 protocol uses the
PLCS type.

6 In the Local/remote field, choose “Local.”

The MSG instruction includes an embedded setup screen for data not shown
directly in the ladder program.

To configure the Setup Screen for each MSG instruction:

1 Double click “Setup Screen” at the bottom of the MSG instruction block.

—+MSG - N7:50 : (14 Elements)

i~ This Controller i~ Control Bit

Commurication Command
Data Table Address
Size in Elements

PLCS Read

N

Igrore if timed out [TO
Ta be retried (MR
Awaiting Execution [E'W

Continuous Run (CO

I
)
)
]
Ermor [ER);
)
)
)

Channel

- Target Devic Message done (DM
Message Timeout
Data Tabls Addiess: [N7.5

Local Mode Addr [dec]:
Local / Remote

Message Transmitting (5T
Message Enabled [EN
“Wwaiting for Queue Space

ID Bmf
EEEEEEEEE

[actal)

r~ Ermor

Emor Code[Hex): O

i~ Enor Description

Mo ermors

2 In the General tab of the MSG dialog box, refer to the This Controller group. In
the Data Table Address field, select the area of PLC memory to use in the read/write
transaction with the inverter.
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3 In the Size in Elements field, enter the number of data words (16-bit items) to
read or write.

4 In the Channel field, select “0.”




Connecting to an Allen-Bradley DF1 Network

5 The Target Device Group contains settings for the SC-OPE. In the Data Table
Address field, enter the starting register address for the inverter data to be read or
written. In this example, the following registers will be read:

Address Data Contents
N7:5 Preset Frequency
N7:6 Acceleration Time
N7:7 Deceleration Time
N7:8 Run Status

6 In the Local Node Addr (dec) field, enter the node address (in decimal) of the
targeted SC-OPE on the network for this MSG instruction.

When using network control of the inverter, the SC-OPE maps (translates) network
commands to specific inverter parameters. When writing your host computer
control program, you will need a map of network registers and inverter parameters.
Please refer to Appendix D and Appendix E for network register maps.

Note: For help in creating the ladder program for your application, please refer to

your Allen-Bradley PLC documentation or distributor support.
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Connecting to a Metasys N2 Network

The SC-OPE 3H can provide an interface for Hitachi SJ300 / L300P inverters to
Johnson Controls’ Metasys N2 network. Metasys N2 is a building automation
network used for HVAC, power management, security, etc.

Physical Bus The connections for the N2 Network are located on the network port connector at
Connections the bottom of the SC-OPE 3H. The diagram below shows the connections from the
SC-OPE to a MetasysN2 network, which is the 2-wire type.

Host Computer SC-OPE Metasys N2
(network master) devices
. RS-422/485
Transceiver .
e . 2-wire network
® TX+ ° N2+
° TX- ° N2—
RX+ y & Ref
1 RX—
[ ]
° GND

Remember to add a termination resistor at each physical end of the network, or
verify that the device at the end has internal termination. Bias resistors are also
important. See “Network Termination” on page 4-8.

SC-OPE 3H The following list describes the SC-OPE 3H communications behavior on Metasys
Implementation N2 networks.

Notes for N2
* The overriding of Al and BI points is not supported. Overrides of Al and BI

points will be acknowledged. However, the Override Value will be ignored and the
Override Flag will not be set.
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* Out-of-range values on overrides of AO, ADI, and ADF points will receive a neg-
ative acknowledge (NAK) response).
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 Certain ADI and ADF points contain read-only values and cannot be overridden.
These particular points are noted in the following Point Table. Overrides of these
ADI and ADF points will be acknowledged but the Override Value will be ignored
and the Override Flag will not be set.

* When an override is released, the point value will remain at the current Override
Value and will not revert back to its value prior to the override. This rule applies to
all point types.

The appendices contain a network point list for Johnson Controls Metasys N2.
See “SJ300 and L300P Building Network Register Maps” on page D—18.
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Troubleshooting and Diagnostics

Basic Troubleshooting
The following list provides general troubleshooting tips:

» When changing inverter parameters or configuring the SC-OPE, verify the effect
of each adjustment as it is made. If too many adjustments are made before
checking for proper operation, it may be very difficult to determine the cause of a
sudden problem.

+ Ifand when a problem arises, try to determine the most recent change made to
the system. It may have been a parameter value change, wiring change, etc.
Examine the latest change(s) for errors, or restore the most recent known working
system configuration.

* When it is difficult to narrow the problem down to a single component, try sub-
stituting a spare part (SC-OPE, cable, etc.) for the most likely problem component.

* Load a known working set of parameters from one inverter to the problem
inverter (via the SC-OPE as a copy unit).

* Substitute a simpler method of operation. For example, if network control is not
working, try keypad control. If the speed control potentiometer input does not
work, verify that the speed control register (FO01) method does work. If the
simpler method of operation does not work, the more complex method has little
chance of working.

* Troubleshooting a new application is different from troubleshooting a system
that is already installed and was once working. For new applications, it is impor-
tant to follow the installation instructions step by step (for the inverter and for the
SC-OPE).

 For an existing application that has stopped working, check for simple things
likely to interrupt proper operation — such as input power, a changed Hand/Auto
mode on the SC-OPE, a loose cable or wiring terminal, a missing input signal from
another system, etc.
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Basic Troubleshooting

Basic Symptoms The following table lists basic symptoms and possible causes and solutions. More
detailed troubleshooting tips are in the next section.

Symptom

Possible Causes and Solutions

SC-OPE display is blank and
its Power LED is OFF

Inverter power is OFF. Check input power, circuit
breakers or fuses, or cutoff switches.

Cable from SC-OPE to inverter is loose. Check the
connections at each end of the cable.

Inspect the RJ45 modular jacks for damage (one on
the inverter, one on the SC-OPE), which the communi-
cations cable uses.

The cable from SC-OPE to inverter may be defective.
Substitute a new cable.

If you suspect the SC-OPE may be defective, replace it
with the original inverter keypad or another known
working SC-OPE.

SC-OPE display output has
changed from its normal
output for normal operation.

Perhaps another person or event changed the mode or
state of the SC-OPE. As a starting point, you can reset
the SC-OPE to its powerup state by pressing and
holding the MODE key for 6 seconds.

SC-OPE was operating under
network control (Net Ctrl), but
somehow the SC-OPE has
changed to keypad control
(Key Ctrl)

If the SC-OPE is configured to change from network
control to keypad control via the Stop key, a Stop key
press event may have caused the exit from network
control. Manual intervention will be necessary to return
the SC-OPE to network control. See “Selecting
Keypad or Network Control” on page 3—4.

Error code is displayed

The inverter has probably tripped due to over-current,
over-voltage, etc. Refer to the inverter manual for inter-
preting error codes. Press the STOP key to clear the
error from the display.

Motor does not move upon a
Run command

Speed input may be zero. This may be confirmed by
viewing the contents of parameter FO01 (via Monitor
Mode). If sourced externally, also check input termi-
nals or network command operation, etc.

The Run command may not be reaching the inverter.
This may be confirmed by checking the Run LED on
the SC-OPE keypad.
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Troubleshooting SC-OPE/Inverter Control Inputs

Keypad versus
Network Control

1y

Run Command
and Speed
Setting Sources

The inverter is always either under SC-OPE keypad or network control. That is, the
SC-OPE is configured either to send commands from its keypad, or to pass control
commands through from an attached network. Press the Monitor Mode key to view
which setting is in effect. See “Selecting Keypad or Network Control” on page 3—
4.

When using keypad control:
5 T v 12
 The Run command and Frequency B, BHz
Setting sources must be set to come from Ruri OPE/Fra:OPE
Morm Stor § Kew Chrl
the keypad... Run:OPE/Frq:OPE.

-

When using network control: Control source = SC-OPE Keypad

* For network control to operate, either or -
both the Run Source and Frequency Source A, &,
settings must be “OPE.” A configuration of | FunsOFPESFra:0FE
Run:TRM/Frq:TRM will not follow the Morm Stor f o Met Cirl
network commands. ~

EIE

Control source = Network
* You can choose the SC-OPE’s response

to the Stop Key — whether there is no action, or whether it will change the SC-
OPE control source setting from Network Control to Keypad Control. See “SC-
OPE Network Configuration” on page 4—12.

Tip: If you are having difficulty getting network control to work, try using keypad
control to verify that you can get the motor turning. It is easier to troubleshoot
more basic problems by using the SC-OPE keypad.

Getting the inverter and motor to respond

depends on several factors, but primarily - . HH 5 . BHHEEIEH
inverter input power, a working Run A E DF’é." Fras Dpé) =
command source, and a non-zero speed Horm Y:H:-DF' I Eea Cirl
(output frequency) reference. The

inverter can be configured to accept a L Hand/Auto setting

Run command from one of several

sources; the same is true for the speed setting. This flexibility can make trouble-
shooting difficult, but the SC-OPE’s Monitor Mode can help you determine these
respective settings. In Monitor Mode, use the Hand/Auto key to change these set-
tings to match the actual sources your system provides for the inverter. See “Hand/
Auto Key Operation” on page 3-30.
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After verifying the Run command source and Speed Setting source are correct, use
the following table if the inverter/motor still does not respond.

Symptom Related Configurations and Solutions

If the inverter is configured to expect the Run

command from the input terminals (Run:TRM):

» Ensure one of the intelligent inputs is programmed
for the appropriate FWD or REV function.
Note: The SJ300/L300P inverters have a built-in
[FWD] terminal.

» Use a digital voltmeter (DVM) to measure the
voltage at the [FWD] or [REV] terminal when the
Run command is active and inactive.

No Run Command
Run command does not cause
motor to turn or engage (Run

LED is OFF) If you are using the SC-OPE keypad as the Run

command source (Run:OPE):

* You can test the keypad keys individually. See
“Keypad and LED Diagnostics” on page 5-7.

* The [REV] key may be independently disabled via
the SC-OPE configuration. See “Limiting the Direc-
tion of Rotation” on page 4-15.

If you are using the SC-OPE keypad (Frq:OPE) to edit

the output frequency (FO01) directly:

» Use Monitor Mode to verify the value of FOO1 (on
second line of display). If it is zero, use the Change
Data key and Arrow keys to change the value.

» Check the value of the maximum output frequency.

If the output frequency setting comes from the analog

input terminals (Frq:TRM):

» Use a digital voltmeter (DVM) to verify the input
voltage and polarity, or current and direction at the
terminals.

No Frequency Setting
Run command causes Run
LED to turn ON, but motor
does not turn

» Check the value of the maximum output frequency.

If the output frequency source is set to come from the

keypad potentiometer (Frq:VM):

* Note that the Frq:VM setting requires the use of the
original Hitachi keypad (with potentiometer) to set
the output frequency for this configuration. For
SC-OPE use, do not set the frequency source to
FRQ:VM.
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Performing SC-OPE Diagnostics

The Configuration Menu in the SC-OPE features a Diagnostics Mode. You can
perform diagnostics to verify proper keypad operation, LED indicator illumina-
tion, and network port operation. The network port check assumes a loopback con-
nection exists. In order to pass the network port part of the diagnostics, you must
install the loopback connection. However, you can perform diagnostics on the
keypad keys without installing a loopback connector — but the network port test

will fail.
Network Port To prepare a loopback connector for the network port (RS422/485):
Loopback Test . ) L . .
1 Find the connector plug in the Bezel Kit to install jumper wires for the loopback.
A Caution: Use insulated wire (not bare wire) for the loopback jumpers. Otherwise,
a short circuit may develop.

2 Connect TX+ (terminal 1) to RX+ (terminal 4)
3 Connect TX- (terminal 2) to RX- (terminal 5)

4 Connect a termination resistor (120 Q) from TX+ (terminal 1) to
TX— (terminal 2)

5 Insert the connector plug into the SC-OPE network port connector.

10987654321

L LIILJLI]]]

Network Port, RS-422/485 Connector

SC-OPE Bezel/
Ty s Housing Assembly

Connector Plug (keypad facing

down)

(terminal screws

. |10987654321|
facing down)

120 Q

Loopback Configuration
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Performing SC-OPE Diagnostics

Keypad and LED To perform SC-OPE keypad and LED diagnostics:

Diagnostics . .
1 Access the Configuration Menu, using the Mode key as shown.

Confia Trarnsfer Mods
Moditins for FC...
Frezs MODE kew for

Confisuration mernu.

(hold 4 seconds) \

Comfiauration Meru
? Irverter Port Cfa
i

(press once)

2 Scroll down the Configuration Menu list with the Down Arrow key as shown
until you reach the Diagnostics Mode menu item.

Corfisuration Menu
‘{;}7 > Haosrnostics Mode
[Enter lEea.,

o e o
(press 5 times) Loorback

3 Press [Enter] to enter the Diagnostics Mode. The network serial port test occurs
immediately and the result is given on the display’s bottom line.

DIGEHOSTICS MODE
Q :> FRESS @Y KEY
Fort Dioa PASSED

(press once)

4 Observe that the three LEDs are flashing ON repeatedly in the sequence:

v

LED Test:
(:) POWER LED
v

+ O runiep
v

. FAULT LED
L1
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5 The keypad test is operator-driven. When you press any key shown below, the
display prints the name of that key for verification.

QUICK
i MONITOR MENU | [PROGRAM
CHANGE READ
<i::t] [j::>> DATA MODE WRITE
Q J J
STORE ESC
ENTER CANCEL HELP
J . J
S
STOP HAND
RESET AUTO

For example, press the Program key to display its name on the third display line.

HEQEHQSTASS}EDDE
> RESS AHY KEY
HHHHII FROGRAM KEY
Fort Dioa PRZSED

=5
(press once)

6 Returning to normal SC-OPE operation requires you to reset the SC-OPE. Press
and hold the Mode key for 6 seconds; release it when the Startup Screen displays.

> HITRCHI AMERICA: Lid
SC-0PE 21 -LIOEP
----- Yer 2.18 -----

(hold 6 seconds)
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SJ300 / L300OP Inverter Program Menu List

Monitor Vars

Parameters

Note: Parameters with an asterisk (*) are available only on the SJ300 (not L300P).

O

O Initial

v Base Settings

v Speed/Jogging

0 Var1.1

Vv Var 1.2
v Var 1.3
Vv Var 2

O Initialize Mode
Vv Country Code
¥ Reintialize Drive
v Debug Mode Sel
¥ Run Key Routing

[0 Freq Set Method
¥ Run Set Method
V¥ Base Frequency
¥ 2nd Base Freq
v 3rd Base Freq
¥ Max Frequency
¥ 2nd Max Freq

v 3rd Max Freq

v AVR Selection

¥ Motor Voltage

v Carrier Freq

[0 Multi-Speed Sel
¥ Multi-Speed 0
v 2nd Multi-Spd 0
v 3rd Multi-Spd 0
v Multi-Speed 1
v Multi-Speed 2
¥ Multi-Speed 3
¥ Multi-Speed 4

B084
B085

C091
F004

A001
A002
C03

A203
A303
A004
A204
A304
A081
A082
B083

A019
A020
A220
A320
A021
A022
A023
A024
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¥ Multi-Speed 5 A025
v Multi-Speed 6 A026 -
v Multi-Speed 7 A027 Sov
¥ Multi-Speed 8 A028 58
v Multi-Speed 9 A029 ==
v Multi-Speed 10 A030 23
v Multi-Speed 11 A031 5°
V¥ Multi-Speed 12 A032
v Multi-Speed 13 A033
V¥ Multi-Speed 14 A034
v Multi-Speed 15 A035
v Jogging Freq A038
v Jogging Mode A039
v VIF Character 0 Torq Boost Sel" A041
¥ 2nd Torq Boost" A241
¥ Man Torq Boost" A042
v 2nd Man Boost", A242
v 3rd Man Boost", A342 *
¥ Man Boost Point A043
v 2nd Man Point", A243
v 3rd Man Point", A343
v 1st Ctrl Method A044
Vv 2nd Ctrl Method A244
v 3rd Ctrl Method A344 *
V¥ Outpt Volt Gain A045
v DC Braking [0 DCB Selection A051
v DCB Frequency A052
v DCB Delay Time A053
v DCB Power A054
v DCB Time A055
v DCB Edge/Level A056
v DCB Pwr Strt T A057
v DCB Tim Strt T A058

v DCB Carrier Frq A059
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v Braking Ctrl

v PID Control

v BRD

v Operation

00 Brake Ctrl Sel

¥ Wait Tm Release
v Wait Time Accel
v Wait Time Stop
v Wait Time Signl
¥ Release Freq

V¥ Release Current

[0 PID Selection

v PID P Gain

v PID | Gain

v PID D Gain

v PID Scale

v PID Feedbak Sel
v PID Deviation

0 BRD Use Rate
v BRD Select
v BRD On Level

[0 Oper Mode Sel
Vv Energy-Save Adj
Vv 1st 2-Stage Adj
V¥ 2nd 2-Stage Adj
v Start Reduced V
v Start Freq Adj

Vv Up/Down Select
¥ Reset Selection
¥ Reset Frq Match
¥ Running Direct.

B120 *
B121 *
B122 *
B123 *
B124 *
B125 *
B126 *

AO071
A072
A073
A074
A075
A076
C044

B090
B095
B096

A085
A086
A094
A294
B036
B082
C101
C102
C103
F004
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v Free VIF 0 Free V/F Freq 1 B100
Vv Free V/F Volt 1 B101 )
v Free V/F Freq 2 B102 o
v Free V/F Volt 2 B103 £8
¥ Free V/F Freq 3 B104 (3%5
¥ Free V/F Volt 3 B105 ; %
¥ Free V/F Freq 4 B106 2
v Free V/F Volt 4 B107
Vv Free V/F Freq 5 B108
v Free V/F Volt 5 B109
Vv Free V/F Freq 6 B110
Vv Free V/F Volt 6 B111
Vv Free V/F Freq 7 B112
v Free V/F Volt 7 B113
v Accel 0 1st Accel Time F002
V¥ 2nd Accel Time F202
v 3rd Accel Time F302 *
v 1st Accel Time2 A092
v 2nd Accel Time2 A292
v 3rd Accel Time2 A392 *
v 1st Acc Freq 2 A095
¥ 2nd Acc Freq 2 A295
v Accel Pattern AQ097
V¥ Acc Curve Const A131
v Decel 0 1st Decel Time F003
¥ 2nd Decel Time F203
v 3rd Decel Time F303 *
v 1st Decel Time2 A093
v 2nd Decel Time2 A293
v 3rd Decel Time2 A393 *
Vv 1st Dec Freq 2 A096
¥ 2nd Dec Freq 2 A296
V¥ Decel Pattern A098

V¥ Dec Curve Const A132
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v Protection O E-Thermal

v Overload

¥ Frequency

00 E-Therm Level
v 2nd E-Thm Level
v 3rd E-Thm Level
Vv 1st E-Thm Char
v 2nd E-Thm Char
Vv 3rd E-Thm Char
v E-Thm Freq 1

v E-Thm Current 1
v E-Thm Freq 2

v E-Thm Current 2
Y E-Thm Freq 3

v E-Thm Current 3
¥ Thermal Warning

00 OLoad Method
Vv OLoad Level

V¥ OLoad Const

Vv OLoad Method 2
v OLoad Level 2

V¥ OLoad Const 2
v Adv Notice Mode
v Adv Level OL

v Adv Level OL2

0 1st Frq Upr Lmt
v 2nd Frq Upr Lmt
v 1st Frq Lwr Lmt
v 2nd Frg Lwr Lmt
¥ Jump Freq 1

v Jump Width 1

v Jump Freq 2

v Jump Width 2

v Jump Freq 3

v Jump Width 3

v Accel Stop Freq
v Accel Stop Time

B012
B212
B312 *
B013
B213
B313 *
B015
B016
B017
B018
B019
B020
C061

B021
B022
B023
B024
B025
B026
C040
C041
C111 ~

A061
A261
A062
A262
A063
A064
A065
A066
A067
A068
A069
A070
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v IPF Restart 00 Retry Selection B001
v Failure Time B002 -
v Retry Wait Time B003 Sov
v Trip During Stp B004 g §
v Retry Time Sel B005 ==
V¥ Open-Phase Sel B006 2 §
v Freq Set Match B007 5°
v N-Stop IPF Sel B050 *
v N-Stop Strt VIt B051 *
v OV-LAD Stop Lvl B052 *
v IPF Decel Time B053 *
Vv IPF Decel Width B054 *
¥ Resume FRS Mode B088
v Stop Mode Sel B091
¥ Torque Limit [0 Torq Limit Sel B040 *
v Torq Limit1 F-D B041 *
v Torq Limit2 R-R B042 *
v Torq Limit3 R-D B043 *
v Torq Limit4 F-R B044 *
Vv Torq LADSTP Sel B045 *
¥ Thermistor 00 Thermistor Sel B098
¥ Therm Err Level B099
V¥ Thermistor Adj C085
v Other ] Dir. Restrict B035
¥ Rev Run Prevent B046 *
v SW Lock Mode B031
v Stop Key Enable B087
Vv Cool Fan Ctrl B092

v Debug Mode Sel C091
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v Terminal

0 Input Defs

Vv Input States

v Analog Input

O Input Term 1"
¥ Input Term 2"
¥ Input Term 3"
¥ Input Term 4"
¥ Input Term 5"
¥ Input Term 6"
¥ Input Term 7"
¥ Input Term 8"

O Input 1 NO/NC
V Input 2 NO/NC
¥ Input 3 NO/NC
¥ Input 4 NO/NC
V¥ Input 5 NO/NC
¥ Input 6 NO/NC
¥ Input 7 NO/NC
¥ Input 8 NO/NC

v Inp FWD NO/NC

O AT Term Select
v O2 Term Select
v O Start Freq

v O End Freq

v O Start Rate

v O End Rate

v O Start Select

v Sampling Number

v Ol Start Freq
v Ol End Freq

v Ol Start Rate
v Ol End Rate
v Ol Start Select
v O2 Start Freq
v O2 End Freq
v O2 Start Rate
v O2 End Rate

C001
C002
C003
C004
C005
C006 *
Coo7 *
C008 *

con
C012
C013
C014
C015
C016 *
Cco17 *
co18 *
C019

A005
A006
A0

A012
A013
A014
A015
A016
A101
A102
A103
A104
A105
A1

A112
A113
A114
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v Analog Meter

Vv Output Defs

v Output States

v Output Levels

0 AM Adjustment
¥ FM Adjustment
v O Adjustment
v Ol Adjustment
v O2 Adjustment
v AM Offset Adj
v AMI Adjustment
v AMI Offset Adj
Vv O Zero Adjust
v Ol Zero Adjust
v O2 Zero Adjust

O Output Term 11
v Output Term 12
Vv Output Term 13
v Output Term 14
v Output Term 15
v Alarm Output
¥ FM Selection
v AM Selection
v AMI Selection

O Output 11 NO/NC
Vv Output 12 NO/NC
v Output 13 NO/NC
v Output 14 NO/NC
V¥ Output 15 NO/NC
v Alarm Out NO/NC

0 RNT/ONT Level
v Accel Arv Freq
Vv Decel Arv Freq
¥ 2nd Accel Arv F
¥ 2nd Decel Arv F
v F-D Over Torq
¥ R-R Over Torq
v R-D Over Torq

B080
B081
C081
C082
C083
C086
Cco87
C088
C121
C122
C123

C021
C022
C023 *
c024 *
C025 *
C026
Cco027
C028
C029

C031
C032
C033 *
C034 *
C035 *
C036

B034
C042
C043
C045 *
C046 *
C055 *
C056 *
Co57 *
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v Motor Settings

¥ F-R Over Torq
Vv Alarm Code Sel
¥ 0 Speed Detect

00 Autotuning Sel
Vv 1st Const Sel

¥ 2nd Const Sel

v 1st Allow Sel

v 2nd Allow Sel

v 1st Mtr Pol Sel
V¥ 2nd Mtr Pol Sel
Vv 1st Speed Resp
V¥ 2nd Speed Resp
v 1st Stab Factor
V¥ 2nd Stab Factor
v 3rd Stab Factor
v 1st Const R1

v 2nd Const R1

v 1st Const R2

v 2nd Const R2

v 1st Const L

v 2nd Const L

Vv 1st Const lo

¥ 2nd Const lo

Vv 1st Const J

v 2nd Const J

v 1st Const R1 AT
v 2nd Const R1 AT
v 1st Const R2 AT
v 2nd Const R2 AT
Vv 1st Const L AT
v 2nd Const L AT
Vv 1st Const lo AT
v 2nd Const lo AT
Vv 1st Const J AT
v 2nd Const J AT

C058 *
Cco62 *
C063 *

HO0O1 *
H002 *
H202 *
HO003

H203

HO004

H204

HO05 *
H205 *
HO006

H206

H306 *
H020 *
H220 *
HO021 *
H221 *
H022 *
H222 *
H023 *
H223 *
H024 *
H224 *
HO30 *
H230 *
HO031 *
H231 *
HO032 *
H232 *
HO033 *
H233 *
HO034 *
H234 *
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v P/PI Switching

v Option

0 1st Pl Pro Gain
v 2nd PI Pro Gain
v 1st Pl Int Gain

v 2nd PI Int Gain
v 1st P Pro Gain

V¥ 2nd P Pro Gain
v 1st OHz-SLV Lmt
v 2nd OHz-SLV Lmt
V¥ Pl Pro Gain Sw
v Pl Int Gain Sw

¥ P Pro Gain Sw

O Opt 1 Err Sel

v Opt 2 Err Sel

v Feedbck Opt Sel
V¥ Encdr Pulse Set
v Ctrl Mode Sel

Vv Pulse Train Sel
v Orient Stop Pos
Vv Orient Spd Set

v Orient Dir Sel

V¥ Orient Comp Rng
Vv Orient Comp Dly
V¥ Gear Pos Select
v Gear Numerator
v Gear Denominatr
V¥ Pos Fwd Gain

V¥ Pos Loop Gain

v Comp 2nd Res

v OverSpeed Level
Vv SpeedErr Level
Vv Acc/Dec Select
v P-Set Select

V¥ Frq During Snap

H050 *
H250 *
HO051 *
H251 *
HO052 *
H252 *
HO60 *
H260 *
HO70 *
HO71 *
HO72 *

P001

P002

P010 *
PO11 *
PO12 *
PO13 *
P014 *
P0O15 *
P016 *
PO17 *
PO18 *
P019 *
P020 *
P021 *
P022 *
P023 *
P025 *
P026 *
P027 *
P031

P032 *
P0O50 *
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Status

v Communications

0 Monitor Values

v Operation Status

v Frequency Status

[0 Data Command
v Baud Rate

v Address Code
v Data Bits

v Parity

v Stop Bits

v Waiting Time

O Current Freq

v Output Cur (A)
¥ Rotation Dir.

v PID Feedback
¥ Inp. Terminals
v Out. Terminals
v Freq Multiplier
Vv Scaled Freq

v Torque

v Output Voltage
v kW Power

¥ Accum Run Time
Vv Power On Time
v Input Voltage

v P-N Voltage

[J Status Byte 1
v Status Byte 2
Vv Status Byte 3
v Status Byte 4

[0 VM Freq Set

v TRM Freq Set
v OPE Freq Set
v OPT1 Freq Set
v OPT2 Freq Set
v RS485 Freq Set

C070
C0o71
C072
C073
Co074
C075
C078

D001
D002
D003
D004
D005
D006
B086
D007
D012
D013
D014
D016
D017
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Trips O O #of Trips D080
vV Trip 1 Err Code D081 )
v Trip 1 Status D081 o
v Freq at Trip 1 D081 £8
v | at Trip 1 D081 %5
v PN-V at Trip 1 D081 i%
¥ Run-Time Trip 1 D081 e
v Pwr-Time Trip 1 D081
V Trip 2 Err Code D082
Vv Trip 2 Status D082
¥ Freq at Trip 2 D082
Vv | at Trip 2 D082
Vv PN-V at Trip 2 D082
¥ Run-Time Trip 2 D082
v Pwr-Time Trip 2 D082
Vv Trip 3 Err Code D083
Vv Trip 3 Status D083
V¥ Freq at Trip 3 D083
v latTrip 3 D083
Vv PN-V at Trip 3 D083
¥ Run-Time Trip 3 D083
¥ Pwr-Time Trip 3 D083
V Trip 4 Err Code D084
Vv Trip 4 Status D084
Vv Freq at Trip 4 D084
v | at Trip 4 D084
Vv PN-V at Trip 4 D084
¥ Run-Time Trip 4 D084
¥ Pwr-Time Trip 4 D084
v Trip 5 Err Code D085
¥ Trip 5 Status D085
Vv Freq at Trip 5 D085
v latTrip5 D085
Vv PN-V at Trip 5 D085

¥ Run-Time Trip 5 D085
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Network 0 0
Control

Software 0 0
Lock
Debug Mode O a

Edit Mode O Inverter Port Cfg
v Network Port Cfg

¥ Pwr-Time Trip 5
¥ Trip 6 Err Code
v Trip 6 Status

V¥ Freq at Trip 6

v | at Trip 6

¥ PN-V at Trip 6
¥ Run-Time Trip 6
v Pwr-Time Trip 6

Control Method
¥ Host Watchdog
v Timeout Action

Operator Access
v SW Lock Mode

(Address - Data)

Press Esc/Cancel to

exit Debug Mode
O Inverter Type

00 Network Protocol
¥ Network Address
v Port Type

v Baud Rate

v Data bits

v Parity

v Stop Bits

V¥ Flow Control

Vv RTS Delay

v Master/Slave

v Max Gap Tlme
Vv Stop Key Action

D085
D086
D086
D086
D086
D086
D086
D086

B031
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v Store Configuration

v Transfer Mode

v Run Mode
v Diagnostics Mode

v DOP Mode

00 Configuration stored

[0 Waiting for PC...
Press the Mode key to
return to the Edit Menu.

O Exits Edit Mode and
Resets SC-OPE

0 Tests port and keypad.
Hold Mode key to exit.

0 Hitachi Digital Operator
Mode
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SJ100/L100 Inverter Program Menu List

Note: Parameters with an asterisk (*) are available only on the SJ100 (not L100).

Monitor Vars 0O 0 VAR1A1
v VAR 1.2
o v VAR 1.3
o2 v VAR 2
S
Eg Parameters O Initial 0 Debug Mode Sel C091
Se v Run Key Routing F004
" % v Init Mode B084
a v Country Code B085

Vv Voltage Class Code

v Base Settings 0 Freq Set Method A001
¥ Run Set Method A002
V¥ Base Frequency A003
¥ 2nd Base Freq A203 *
v Max Frequency A004 *
v 2nd Max Freq A204
¥ AVR Function A081
v AVR Voltage A082
v Carrier Freq B083

v Speed/Jogging 0 Multi-Speed 0 A020
Vv 2nd Multi-Spd A220 *
¥ Multi-Speed 1 A021
v Multi-Speed 2 A022
¥ Multi-Speed 3 A023
¥ Multi-Speed 4 A024
v Multi-Speed 5 A025
¥ Multi-Speed 6 A026
v Multi-Speed 7 A027

¥ Multi-Speed 8 A028
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B-3

v V/IF Character

v DC Braking

v PID Control

v BRD

¥ Multi-Speed 9
v Multi-Speed 10
v Multi-Speed 11
v Multi-Speed 12
V¥ Multi-Speed 13
v Multi-Speed 14
v Multi-Speed 15
v Jogging Freq
v Jogging Mode

[0 Torq Boost Sel
V¥ 2nd Torq Boost
¥ Man Torq Boost
¥ 2nd Man Boost
¥ Man Boost Freq
v 2nd Man Freq
v V/F Curve

Vv 2nd V/F Curve
v V/F Gain

[1 DCB Selection
v DCB Frequency
v DCB Wait Time
v DCB Force

v DCB Time

00 PID Function
v PID P Gain

v PID | Gain

v PID D Gain
V¥ PV Scale

v PV Source

v PID Deviation

[0 BRD Use Rate

A029
A030
A031
A032
A033
A034
A035
A038
A039

A041
A241
A042
A242
A043
A243
A044
A244
A045

A051
A052
A053
A054
A055

A071
A072
A073
A074
A075
A076
C044

B090
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v Operation

v Accel

v Decel

v Protection

v Terminal

[ Input Defs

[0 2-Stage Adj

Vv 2nd 2-Stage Adj
v Start Freq Adj
¥ Motor Direction

00 Acceleration 1

v 2nd Accel 1

v Acceleration 2

v 2nd Accel 2

v Accel Ch Freq

¥ 2nd Acc Ch Freq
v Accel Curve

V¥ Deceleration 1

v 2nd Decel 1

V¥ Deceleration 2

V¥ 2nd Decel 2

V¥ Decel Ch Freq

v 2nd Dec Ch Freq
Vv Decel Curve

v E-Therm Level
v 2nd E-Thm Level
Vv E-Therm Char
v 2nd E-Thm Char

O Input Term 1
¥ Input Term 2
¥ Input Term 3
¥ Input Term 4
¥ Input Term 5
¥ Input Term 6

A094 *
A294 *
B082
F004

F002
F202 *
A092
A292 *
A095
A295 *
A097

F003
F203 *
A093
A293 *
A096
A296 *
A098

B012
B212 *
B013
B213

C001
C002
C003
C004
C005
C006 *
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V¥ Input States

v Analog Input

v Analog Meter

Vv Output Defs

v Output States

V¥ Output Levels

v Motor Data (SLV)

O Input 1 NO/NC
V Input 2 NO/NC
¥ Input 3 NO/NC
¥ Input 4 NO/NC
V¥ Input 5 NO/NC
¥ Input 6 NO/NC

O Ext Freq Start

v Ext Freq End

Vv Ext Bias Start

v Ext Bias End

v Ext Freq Offset

v Sampling Number
[0 FM Adjustment

Vv L-O Adjustment

v L-Ol Adjustment

[0 Output Term 11

Vv Output Term 12
v Output Term FM
v Output Term AL

O Output 11 NO/NC
Vv Output 12 NO/NC
v Output AL NO/NC

00 Accel Arv Freq
V¥ Decel Arv Freq

O Autotuning Sel
¥ Motor Data

¥ 2nd Motor Data
¥ Motor Capacity
¥ 2nd Motor Cap
¥ Motor Poles

¥ 2nd Motor Poles
v Motor Const Kp
v 2nd Mtr Cnst Kp
Vv Motor Stab Cnst

con
C012
C013
C014
C015
C016 *

A011

A012
A013
A014
A015
A016
B081

C081
C082

Cco021
C022
C023
c024 *

C031
C032
C033

C042
C043

HOO01 *
H002 *
H202 *
HO003 *
H203 *
HO004 *
H204 *
HO05 *
H205 *
H006 *
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Status

0 Monitor Values

v Operation Status

v Frequency Status

¥ 2nd Motor Stab
Vv Motor Const R1
v 2nd Mtr Cnst R1
¥ Motor Const R2
¥ 2nd Mtr Cnst R2
¥ Motor Const L
Vv 2nd Mtr Cnst L
¥ Motor Const lo
Vv 2nd Mir Cnst lo
¥ Motor Const J

v 2nd Mtr Cnst J

O Output Freq

V¥ Output Current
¥ Rotation Dir.
v PID Feedback
¥ Inp. Terminals
v Out. Terminals
¥ Freq Multiplier
Vv Scaled Freq

¥ Input Voltage
v P-N Voltage

v kW Power

v kW Rating

[0 Status Byte
Vv Status State

[0 VM Freq Set
¥ TRM Freq Set

H206 *
H020 *
H220 *
H021 *
H221 *
H022 *
H222 *
H023 *
H223 *
H024 *
H224 *

D001
D002
D003
D004
D005
D006
B086
D007
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Trips O O #of Trips D008
vV Trip 1 Err Code D008
¥ Freq at Trip 1 D008
v | at Trip 1 D008
v PN-V at Trip 1 D008
¥ Time at Trip 1 D008
V Trip 2 Err Code D009
v Freq at Trip 2 D009
v | at Trip 2 D009 RY
v PN-V at Trip 2 D009 % 2
v Time at Trip 2 D009 38
v Trip 3 Err Code D009 5
¥ Freq at Trip 3 D009 =8
v | at Trip 3 D009 3
v PN-V at Trip 3 D009
v Time at Trip 3 D009
Network O O Control Method
Control v Host Watchdog
V¥ Timeout Action
Software O 0 Operator Access
Lock v SW Lock Mode B031
Debug Mode O 0 (Address - Data)

Press Esc/Cancel to
exit Debug Mode
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Edit Mode

O Inverter Port Cfg
v Network Port Cfg

v Store Configuration

v Transfer Mode

v Run Mode

O Inverter Type

00 Network Protocol
¥ Network Address
v Port Type

v Baud Rate

v Data bits

v Parity

v Stop Bits

V¥ Flow Control

Vv RTS Delay

v Master/Slave

v Max Gap Tlme

v Stop Key Action

[0 Configuration stored

[0 Waiting for PC...
Press the Mode key to
return to the Edit Menu.

[0 Exits Edit Mode and
Resets SC-OPE




J300
Program
Menu List

In This Appendix. . . . page
* J300 Inverter Program Menu List. . . .............. 2



C-2

J300 Inverter Program Menu List

Monitor Vars 0O 0 VAR 11

v VAR 1.2

v VAR 1.3

¥ VAR 2
Parameters 0 Command 0 Freq Set Method

¥ Run Set Method
v Param Set Method

v Initial O Trip History Mode
V¥ Enable Debug Mode
¥ Run Key Routing

v Control 0 VIF Settings 0 Base Freq (p)
Vv Base Freq (s)
v Max Freq (p)
v Max Freq (s)
v OPE Set Freq (p)
v OPE Set Freq (s)
v Jogging Freq
v Start Freq
v Ctrl Method (p)
(s)

o
o
™
-

Program Menu Map

v Ctrl Method (s
v V/F Pattern (p)
v V/F Pattern (s)
v Input Voltage
v AVR Dec

¥ Motor Data O Auto Tuning (p)
v Auto Tuning (s)
Vv Motor Const Data (p)
¥ Motor Const Data (s)
Vv Motor Pole Count (p)
¥ Motor Pole Count (s)
¥ Motor Capacity (p)
V¥ Motor Capacity (s)
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¥ Motor Cap (eu) (p)
¥ Motor Cap (eu) (s)
¥ Resistor R1 (p)

V Resistor R1 (s)

¥ Resistor R2 (p)

¥V Resistor R2 (s)

V Inductor L1+L2 (p
¥ Inductor L1+L2 (s
v Mut Inductor M (p
¥ Mut Inductor M (s
¥ Inertia J (p)

¥ Inertia J (s)

v ASR Kp (p)

v ASR Kp (s)

v ASR Ti (p)

v ASR Ti (s)

v ASR Kpp (p)
Vv ASR Kpp (s)

~_~ — — —
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Vv Carrier Freq 0
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v Accel O Accel 1 (p)
v Accel 1 (s)
v Accel 2
v Accel Curve
V¥ Curve Constant

v Decel 0 Decel 1 (p)
Vv Decel 1 (s)
V¥ Decel 2
V¥ Decel Curve
V¥ Curve Constant
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v Operation 0 Frequency Stop

V¥ Operation Pattern

v Multi-stage Speed

¥ Process Advance 1
¥ Process Advance 2
¥ Process Advance 3
¥ Process Advance 4
¥ Process Advance 5
¥ Process Advance 6
¥ Process Advance 7
¥ Process Advance 8

v Braking 0 DC Braking 0 DCB Enable

v DCB Type

v DCB Freq

v DCB Force (start)
v DCB Force (stop)
v DCB Time (start)
v DCB Time (stop)
v DCB Shutoff Time

o
o
™
-

Program Menu Map

¥ Regen Brake Ratiol]

v Protection [ E-Thermal 0 E-Thermal Char (p)
Vv E-Thermal Char (s)
Vv E-Thermal Level (p)
Vv E-Thermal Level (s)
v E-Thermal Current 1
v E-Thermal Freq 1
v E-Thermal Current 2
v E-Thermal Freq
v E-Thermal Current 3
v E-Thermal Freq 3

v Overload [0 Oload Limit level
¥ OLoad Limit Const
¥ OLoad Limit Acc




J300 Inverter Program Menu List -

¥ Freq Protect O Min Freq Limit
¥ Max Freq Limit
v Jump Freq 1
¥ Jump Freq 2
v Jump Freq 3
¥ Jump Freq Width

v IPS O IPS Failure Time
v IPS Wait Time
v IPS Restart Op
v IPS Tripping

v Other 00 Max Freq Select

v SW Lock Mode

v STOP Key Enable
V¥ Operation Direction
¥ Rev Run Prevention

v Terminal 0O Analog Input 0 Analog Input Voltage
v Analog Meter Corr
Vv Ext Freq (start)
v Ext Freq (end)
Vv Ext Freq % (start)
Vv Ext Freq % (stop)

o
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Q
Q
25
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D O
>
c
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Q
©

v Signal Output 00 Freq Arv Pattern
V¥ Targ Accel Freq
v Targ Decel Freq
v Ov-Trq Power
v Ov-Trg Sig Regen

Vv Terminal Defs U Input Pin 1
¥ Input Pin 2
¥ Input Pin 3
¥V Input Pin 4
¥ Input Pin 5
¥ Input Pin 6
¥ Input Pin 7
¥ Input Pin 8




o
©
b=
>
c
7}
b=
IS
©
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o
p
o

v Option

Vv Monitor Signal

(] Option Error

V¥ Option Select

V¥ Orient

Vv Position

v Torque

¥ Input Pin 1 NO/NC

¥ Input Pin 2 NO/NC

¥ Input Pin 3 NO/NC

¥ Input Pin 4 NO/NC

V¥ Output Pin 11

Vv Output Pin 12

Vv Output Pin 1 NO/NC
v Output Pin 2 NO/NC
v Alarm Output NO/NC

O

O OPI Error Oper.
v OP2 Error Oper.

[0 Encoder Pulses
Vv Option Ctrl Mode
¥ Option RO-TO

00 Orient Stop Pos Chg
v Orient Stop Pos

v Orient Speed

Vv Orient Direction

v Orient End Range

v Orient End Delay

0 Gear Setting Pos.
V¥ Gear Ratio (num)
v Gear Ratio (den)
Vv Feed Fwd Gain
v Positional Gain

00 Torque Limiter

¥ Fwd Torque Limit
¥ Rev Torque Limit
Vv Torque Boost (p)
Vv Torque Boost (s)
V¥ V-gain Set Value




J300 Inverter Program Menu List -

v PID 00 PID Switching
Vv Feedback AC/DC
Vv Target PID Value
v PID P Gain
v PID | Gain
v PID D Gain

v Digital O Dig Input Term
v Dig Output Term
v Dig Thermal Level

v Analog O Ana Input Term
v Ana Output Term

¥ Communications [1 COMM Baud Rate
v COMM Station Num
v COMM Data Bits
v COMM Parity
v COMM Parity
v COMM Stop Bits
v COMM Test Mode

Status 0 P/S Selection 0 -

v Operation Status O Status 1
Vv Status 2
Vv Status 3

o
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Q
Q
25
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D O
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c
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©

v Terminal Status 0 Terminal I/O Status
¥ Input Term Info 1
¥ Input Term Info 2
¥ Input Term Info 3
¥ Input Term Info 4
Vv Output Term Info
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v Monitor Values

v Inverter Setup

[0 OPE Freq Set. (p)
Vv OPE Freq Set. (s)
v TRM Freq Set.

Vv OP1 Freq Set.

v OP2 Freq Set.

V¥ Preset Freq

Vv Current Freq

v Freq Multiplier

Vv Scaled Freq

¥ Rotation Dir.

¥ Mot Poles - rpm
V¥ Rotation Speed

v Output Cur (A)

Vv Output Cur (%)

Vv Output Torque (%)
v P-N Voltage

¥ Input Voltage

¥ kW Power

v kW Hours

v kW Ratio

v Total Svc Time

0 Country Code
¥ Model Code
Vv Voltage Class




J300 Inverter Program Menu List -

Trips a 0 Warning (p)
v Warning (s)
v Total # of Trips
Vv Cur. Trip Factor
Vv Trip Factor 1
v Tripping Freq 1
V Tripping Cur 1
¥ Tripping P-N V 1
v Days at Trip 1
v Trip Factor 2
v Tripping Freq 2

¥ Tripping Cur 2

¥ Tripping P-N V 2
v Days at Trip 2

Vv Trip Factor 3

V Tripping Freq 3 g
. q «Q
¥ Tripping Cur 3 3
¥ Tripping P-N V 3 ;
v Days at Trip 3 e
c
Network 0 0 Control Method s
©
Control v Host Watchdog
V¥ Timeout Action
Software 0 0 Operator Access
Lock v SW Lock Mode
Configura- 0 [ENTER]
tion Mode
Reset KW O

Hours
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Bit-level Definitions for Factory 1/0 Registers

Bit-level Definitions for Factory I/0 Registers

Input Terminal

Information

Input Terminal Information (Word 1)

Bit Description Bit Description
0 Position Train Position Command Input 8 Not Used

Enable

1 Not Used 9 Not Used
2 Not Used 10 Not Used
3 Not Used 1 Not Used
4 Not Used 12 Not Used
5 Not Used 13 Not Used
6 Not Used 14 Not Used
7 Not Used 15 Not Used

Input Terminal Information (Word 2)

Bit Description Bit Description
0 Multi-Speed Bit1 8 Torque Limit Enable
1 Multi-Speed Bit2 9 Torque Limit Selection, Bit 1 >
2 Multi-Speed Bit3 10 Torque LimitSelection, Bit 2 %D" o
3 Multi-Speed Bit4 11 Proportional / Proportional/Integral ;%— a
Selection c? S
4 Multi-Speed Bit5 12 Brake Confirmation Signal % 5
5 Multi-Speed Bit6 13 Orientation (Home Search) CE %
6 Multi-Speed Bit7 14 LAC : LAD Cancel _ch)
7 Overload Restriction 15 Position Deviation Reset d




Input Terminal Information (Word 3)
Bit Description Bit Description
0 Analog Input Voltage/Current Select 8 PID Reset
1 Set 3rd Motor data 9 Not Used
2 Reset Inverter 10 Control Gain Setting
3 Not Used 11 Remote Control UP Function
4 Start (3-Wire Interface) 12 Remote Control DOWN Function
5 Stop (3-Wire Interface) 13 Remote Control Data Clearing
6 FWD. REV (3-Wire Interface) 14 Not Used
7 PID Disable 15 Operator Control

Input Terminal Information (Word 4)
Bit Description Bit Description
0 Not Used 8 Set 2nd Motor
1 Reverse Run/Stop 9 2-Stage Accel and Decel
2 Multi-speed select, bit1 10 Not Used
" 3 Multi-speed select, bit 2 1" Free-run Stop
o
© 4 Multi-speed select, bit 3 12 External Trip
o=
8 5 5 Multi-speed select, bit 4 13 Unattended Start Protection
R =
— % 6 Jogging 14 Commercial Power Source
—
Q
8 1 7 External DC Braking 15 Software Lock
S
%) o
2
[}
P4




Bit-level Definitions for Factory 1/0 Registers

Output terminal
Information

Output Terminal Information (Word 1)

Bit Description Bit Description

0 Not Used 8 Frequency Arrival Type 4 —
over-frequency 2

1 Not Used 9 Frequency Arrival Type 5 —
at-frequency (2)

2 Not Used 10 Overload Advance Notice Signal (2)

3 Brake Release Signal 1 Not Used

4 Brake Error Signal 12 Not Used

5 Zero Speed Detect 13 Not Used

6 Speed Deviation Maximum 14 Not Used

7 Position Completion 15 Not Used

Output Terminal Information (Word 2)

Bit Description Bit Description
0 Run Signal 8 Instantaneous Power Failure Signal
1 Frequency Arrival Type1 — Constant 9 Under-voltage Signal

Speed
2 Frequency Arrival Type 2 — 10 In Torque Limit
Over-frequency
3 Overload Advance Notice Signal (1) 11 Operation Time Over
4 Output Deviation for PID Control 12 Plug-in Time Over
5 Alarm Signal 13 Thermal Alarm Signal
6 Frequency Arrival Type 3 — at frequency 14 Not Used
7 Over-torque Signal 15 Not Used
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Intelligent Input
Setting Codes

Intelligent Input Terminal Setting Codes

Code Description Code Description
01 RV: Reverse Run/Stop 26 CAS: Control Gain Setting
02 CF1: Multi-speed select, bit 0 27 UP: Remote Control UP Function
03 CF2: Multi-Speed select, bit 1 28 DWN: Remote Control DOWN Function
04 CF3: Multi-speed select, bit 2 29 UDC: Remote Control Data Clearing
05 CF4: Multi-speed select, bit 3 30 Not Used
06 JG: Jogging 31 OPE: Operator Control
07 DB: External DC Braking 32 SF1: Multi-Speed Bit1
08 SET: Set 2nd Motor Data 33 SF2: Multi-Speed Bit2
09 2CH: 2-Stage Accel and Decel 34 SF3: Multi-Speed Bit3
10 Not Used 35 SF4: Multi-Speed Bit4
11 FRS: Free-run Stop 36 SF5: Multi-Speed Bit5
12 EXT: External Trip 37 SF6: Multi-Speed Bit6
13 USP: Unattended Start Protection 38 SF7: Multi-Speed Bit7
14 CS: Commercial Power Source 39 OLR: Overload Restriction
15 SFT: Software Lock 40 TL: Torque Limit Enable
16 AT: Analog Input Voltage/Current 41 TRQ1: Torque Limit Selection, Bit 1
Selection
17 SET3: Set 3rd Motor Data 42 TRQ2: Torque Limit Selection, Bit 2
18 RS: Reset Inverter 43 PPI: Proportional Proportional/Integral
Mode Selection
19 Not Used 44 BOK: Brake Confirmation
20 STA: Start (3-Wire Interface) 45 ORT: Orientation (Home Search)
21 STP: Stop (3-Wire Interface) 46 LAC: LAD Cancel
22 F/R: FWD/REV (3-Wire Interface) 47 PCLR: Position Deviation Reset
23 PID: PID Disable 48 STAT: Pulse Train Position Command
Input Enable
24 PIDC: PID Reset — —
25 Not Used 255 | NO: No Assignment to Terminal
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Bit-level Definitions for Factory 1/0 Registers

Intelligent
Output Setting
Codes

Intelligent Output Terminal Setting Codes

Code Description Code Description
00 RUN: Run Signal 14 Not Used
01 FA1: Frequency Arrival Type 1 — 15 Not Used
constant speed
02 FA2: Frequency Arrival Type 2 — over- 16 Not Used
frequency
03 OL: Overload Advance Notice Signal (1) 17 Not Used
04 OD: Output Deviation for PID Control 18 Not Used
05 AL: Alarm Signal 19 BRK: Brake Release Signal
06 FA3: Frequency Arrival type 3 — 20 BER: Brake Error Signal
at frequency
07 OTQ: Over-torque Signal 21 ZS: Zero Speed Detect Signal
08 IP: Instantaneous Power Failure Signal 22 DSE: Speed Deviation Maximum
09 UV: Under-voltage Signal 23 POK: Positioning Completion
10 TRQ: In Torque Limit 24 FA4: Frequency Arrival type 4 —
over- frequency (2)
11 RNT: Operation Time Over 25 FAS5: Frequency Arrival Type 5 —
at frequency (2)
12 ONT: Plug-in Time Over 26 OL2: Overload Advance Notice Signal
2
13 THM: Thermal Alarm Signal — —
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SJ300 and L300P Building Network Register Maps

Metasys N2 This section is for interfacing the SC-OPE 3H to a Johnson Metasys N2 building

Point Map network, commonly used in HVAC applications. The following table contains the
Network Point Type (NPT), Network Point Address (NPA), Engineering Units
(Units), Point Description, Range/Value, and Notes for each point supported in
version 1.06 of the SC-OPE 3 for the Hitachi SJ300/L300P series inverters.

NPT NPA | Units Point Description Range/Value é\dju_stl
verride
Al 1 Hz Current Frequency (D001) 0 — 400 o
Al 2 Hz Preset Frequency (F001) 0 — 400 O
Al 3 A Output Current Monitor (D002) 0 —6553.5 o
Al 4 % PID Feedback Monitor (D004) 0 — 99999.99 ]
Al 5 — Frequency Conversion Monitor (D007) 0 — 99999.99 o
Al 6 % Torque Monitor (D012) (SJ300 only) -300 — +300 ]
Al 7 \Y Output Voltage Monitor (D013) 0 —6553.5 o
Al 8 kW Input Power Monitor (D014) 0 —6553.5 ]
Bl 1 — Inverter Offline 0=Online o
1=0Offline
BI 2 — Stop Flag 0=0ff 0
1=Stopped
BI 3 — Run Flag 0=0ff ]
1=Running
(7]
>3 BI 4 — | Tripping Flag 0=0ff O
o= 1=Tripped
O -
QL BI 5 — | Acceleration Flag 0=0ff O
- % 1=Accelerating
~Q
| BI 6 — | Deceleration Flag 0=0ff a
™ X 1=Decelerating
A O
w
E Bl 7 — Constant Speed Flag 0=0ff ]
é’ 1=Constant
Speed
Bl 8 — Forward Flag 0=0ff a
1=Forward
BI 9 — Reverse Flag 0=0ff o
1= Reverse
BI 10 — Input Terminal 1 0=Open 0
1=Closed
BI 1 — Input Terminal 2 0=Open O
1=Closed




SJ300 and L300P Building Network Register Maps

NPT NPA | Units Point Description Range/Value Adju.StI
Override
BI 12 — Input Terminal 3 0=Open O
1=Closed
BI 13 — Input Terminal 4 0=Open O
1=Closed
BI 14 — Input Terminal 5 0=Open ]
1=Closed
BI 15 — Input Terminal 6 (SJ300 only) 0=Open o
1=Closed
BI 16 — Input Terminal 7 (SJ300 only) 0=Open o
1=Closed
BI 17 — Input Terminal 8 (SJ300 only) 0=Open O
1=Closed
BI 18 — Output Terminal 1 0=Open O
1=Closed
BI 19 — Output Terminal 2 0=Open O
1=Closed
Bl 20 — Output Terminal 3 (SJ300 only) 0=Open ]
1=Closed
BI 21 — Output Terminal 4 (SJ300 only) 0=Open o
1=Closed
BI 22 — Output Terminal 5 (SJ300 only) 0=0Open o
1=Closed
AO 1 Hz Frequency Setting (A020/A220/A320) 0.00 — 400.00 O
AO 2 Sec | Acceleration Time Setting (F002/F202/ 0.00 — 3000.00 O
F302)
AO 3 Sec | Deceleration Time Setting (FO03/F203/ 0.00 — 3000.00 O
F303)
BO 1 — Forward Run Command 0=No Action, O
1=Run Forward
BO 2 — Reverse Run Command 0=No Action, O
1=Run Reverse
BO 3 — Stop/Reset Command 0=No Action, O
1=Stop/Reset
ADF 1 Hz 1st Multi-speed 0 (A020) 0.00 — 400.00 O
ADF 2 Hz | 2nd Multi-speed 0 (A220) 0.00 — 400.00 O
ADF Hz | 3rd Multi-speed 0 (A320) (SJ300 only) 0.00 — 400.00 O
ADF 4 Hz Multi-speed 1 (A021) 0.00 — 400.00 O
ADF 5 Hz Multi-speed 2 (A022) 0.00 — 400.00 O
ADF 6 Hz Multi-speed 3 (A023) 0.00 — 400.00 0

d00€T/ 00€rs

Z
@
—
3
o
3
=
A
(0]
Q.
(2]
—-
[©]
=
<
j)
e
(2]




»
a
©

o=

o

S

Qe

_,-(L)

-~

o

Sx

5ol

U)O

2

(0]
zZ

NPT

NPA

Units

Point Description

Range/Value

Adjust/

Override

ADF 7 Hz | Multi-speed 4 (A024) 0.00 — 400.00 O
ADF 8 Hz | Multi-speed 5 (A025) 0.00 — 400.00 O
ADF 9 Hz | Multi-speed 6 (A026) 0.00 — 400.00 O
ADF 10 Hz | Multi-speed 7 (A027) 0.00 — 400.00 O
ADF 11 Hz | Multi-speed 8 (A028) 0.00 — 400.00 O
ADF 12 Hz | Multi-speed 9 (A029) 0.00 — 400.00 0
ADF 13 Hz | Multi-speed 10 (A030) 0.00 — 400.00 O
ADF 14 Hz | Multi-speed 11 (A031) 0.00 — 400.00 0
ADF 15 Hz | Multi-speed 12 (A032) 0.00 — 400.00 O
ADF 16 Hz | Multi-speed 13 (A033) 0.00 — 400.00 0
ADF 17 Hz | Multi-speed 14 (A034) 0.00 — 400.00 O
ADF 18 Hz | Multi-speed 15 (A035) 0.00 — 400.00 0
ADF 19 Sec | 1st Acceleration Time (F002) 0.01 — 3600.00 O
ADF 20 Sec | 2nd Acceleration Time (F202) 0.01 — 3600.00 O
ADF 21 Sec | 3rd Acceleration Time (F302) 0.01 — 3600.00 O

(SJ300 only)
ADF 22 Sec | 1st Deceleration Time (FO03) 0.01 — 3600.00 O
ADF 23 Sec | 2nd Deceleration Time (F203) 0.01 — 3600.00 O
ADF 24 Sec | 3rd Deceleration Time (F303) 0.01 — 3600.00 O

(SJ300 only)
ADF 25 — PID - P Gain (A072) 0.2—5.0 O
ADF 26 Sec | PID - | Gain (A073) 0.0 — 3600.0 0
ADF 27 Sec | PID - D Gain (A074) 0.00 — 100.00 O
ADF 28 — PID - Scale (A075) 0.01 —99.99 0
ADF 29 Hz | Orientation Speed (P015) (SJ300 only) 0.50 — 60.00 O
ADF 30 Sec | Orientation Completion Delay Time 0.00 —9.99 O

(P018) (SJ300 only)
ADF 31 Hr Accumulated Run Time (D016) 0.0 — 999999.9 O
ADF 32 Hr | Accumulate On Time (D017) 0.0 — 999999.9 g
ADF 33 Hz Terminal Set Frequency 0.00 — 99999.99 O
ADF 34 P-N (DC Bus) Voltage 0.0 — 6553.5 g
ADF 35 \% Input Voltage 0.0 — 6553.5 o
ADF 36 Hz | Trip 1 Frequency (D081) 0.00 — 99999.99 g




SJ300 and L300P Building Network Register Maps

NPT NPA | Units Point Description Range/Value Cﬁ::ej::'isctlle
ADF 37 Trip 1 Output Current (D081) 0.00 — 655.35 ]
ADF 38 \ Trip 1 P-N Voltage (D081) 0.0 — 6553.5 a
ADF 39 Hr | Trip 1 Run Time (D081) 0.0 — 999999.9 ]
ADF 40 Hr | Trip 1 Power On Time (D081) 0.0 — 999999.9 a
ADF 41 Hz Trip 2 Frequency (D082) 0.00 — 99999.99 ]
ADF 42 Trip 2 Output Current (D082) 0.00 — 655.35 o
ADF 43 Trip 2 P-N Voltage (D082) 0.0 — 6553.5 ]
ADF 44 Hr | Trip 2 Run Time (D082) 0.0 — 999999.9 o
ADF 45 Hr | Trip 2 Power On Time (D082) 0.0 — 999999.9 ]
ADF 46 Hz | Trip 3 Frequency (D083) 0.00 — 99999.99 o
ADF 47 Trip 3 Output Current (D083) 0.00 — 655.35 ]
ADF 48 Trip 3 P-N Voltage (D083) 0.0 — 6553.5 o
ADF 49 Hr | Trip 3 Run Time (D083) 0.0 — 999999.9 ]
ADF 50 Hr Trip 3 Power On Time (D083) 0.0 — 999999.9 o
ADF 51 Hz Trip 4 Frequency (D084) 0.00 — 99999.99 ]
ADF 52 Trip 4 Output Current (D084) 0.00 — 655.35 o
ADF 53 Trip 4 P-N Voltage (D084) 0.0 — 6553.5 ]
ADF 54 Hr | Trip 4 Run Time (D084) 0.0 — 999999.9 o
ADF 55 Hr | Trip 4 Power On Time (D084) 0.0 — 999999.9 ]
ADF 56 Hz | Trip 5 Frequency (D085) 0.00 — 99999.99 o
ADF 57 A Trip 5 Output Current (D085) 0.00 — 655.35 O
ADF 58 Trip 5 P-N Voltage (D085) 0.0 — 6553.5 g
ADF 59 Hr Trip 5 Run Time (D085) 0.0 — 999999.9 O
ADF 60 Hr | Trip 5 Power On Time (D085) 0.0 — 999999.9 o
ADF 61 Hz Trip 6 Frequency (D086) 0.00 — 99999.99 O
ADF 62 Trip 6 Output Current (D086) 0.00 — 655.35 o
ADF 63 V | Trip 6 P-N Voltage (D086) 0.0 — 6553.5 o
ADF 64 Hr | Trip 6 Run Time (D086) 0.0 — 999999.9 o
ADF 65 Hr Trip 6 Power On Time (D086) 0.0 — 999999.9 0o
ADI 1 Pulse | Orientation Stop Position (P014) (SJ300 0 — 4095 O
only)
ADI 2 — Orientation Direction (P016) (SJ300 only) 0:Forward O

1:Reverse
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NPT

NPA

Units

Point Description

Range/Value

Adjust/

Override
ADI 3 Pulse | Orientation Completion Range (P017) 0 — 10000 O
(SJ300 only)
ADI 4 — Electronic Gear Numerator (P020) 1—9999 O
(SJ300 only)
ADI 5 — Electronic Gear Denominator (P021) 1—9999 O
(SJ300 only)
ADI 6 — AT Terminal Selection (A005) 0:Changing O O
and Ol
1:Changing O
and 02
ADI 7 — PID Selection (A071) 0:0ff O
1:0n

ADI 8 — PID Feedback Selection (A076) 0:From Ol O

1:From O
ADI 9 — Operation Direction Monitor (D003) 0:Stopped ]

1:Forward

2:Reverse
ADI 10 — Trip Counter (D080) 0 — 65535 ]
ADI 11 — Factor/Status of Trip 1 (D081) 0—255 o
ADI 12 — Factor/Status of Trip 2 (D082) 0—255 O
ADI 13 — Factor/Status of Trip 3 (D083) 0—255 o
ADI 14 — Factor/Status of Trip 4 (D084) 0—255 O
ADI 15 — Factor/Status of Trip 5 (D085) 0—255 o
ADI 16 — Factor/Status of Trip 6 (D086) 0—255 O
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Intelligent Terminal Codes

Intelligent Terminal Codes

Intelligent Input
Setting Codes

Intelligent Input Terminal Setting Codes
Code Description Code Description
00 FW: Forward Run/Stop 15 SFT: Software Lock
01 RV: Reverse Run/Stop 16 AT: Analog Input Voltage/Current Select
02 CF1: Multi-speed select, Bit 0 17 Not used
03 CF2: Multi-speed select, Bit 1 18 RS: Reset Inverter
04 CF3: Multi-speed select, Bit 2 19 PTC Themistor thermal Protection
05 CF4: Multi-speed select, Bit 3 20 Not Used
06 JG: Jogging 21 Not Used
07 DB: External DC Braking 22 Not Used
08 SET: Set 2nd Motor 23 Not Used
09 2CH: 2-Stage Accel and Decel 24 Not Used
10 Not Used 25 Not Used
11 FRS: Free-run Stop 26 Not Used
12 EXT: External Trip 27 UP: Remote Control UP Function
13 USP: Unattended Start Protection 28 DWN: Remote Control DOWN Function
14 CS: Commercial Change 29 Not Used
Intelligent
Output Setting
Codes Intelligent Output Terminal Setting Codes
Code Description Code Description
00 RUN: Run Signal 03 OL: Overload Advance Notice Signal
01 FA1: Frequency Arrival Type 1 Signal 04 OD: Output Deviation for PID Control
02 FA2: Frequency Arrival Type 2 Signal 05 AL: Alarm Signal
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A
Allen-Bradley DF1 2-19, 4-2

host program example 4-28

B
Bezel Kit 1-7, 49
Bezel/housing 2—-13

Bias resistors 48

C
Change Data 3—12
Comm port 2—4
Communications cable 2—15
Config Transfer Mode 2-22
Configuration Editor 2—-18, 2—-19
installation 2-20

naming/saving configuration 2—-33

options 2-33
printing a configuration 2—34

uploading a configuration 2-21

viewing multiple configurations 2—-34

Configuration Kit 1-7
Configuration Mode 3-10
Connector plug 2-17, 5-6
Control Method Setting 3—4, 4-11
Conventions in this manual 1-3

Copying parameters 3—25

D

DF1 4-28
Diagnostics 3—10, 56
Dimensions 2—-8
DIN rail 2-12, 2-13
DIN rail clips 2—13
Direction restriction 415
DirectNet 2—19, 4-2

host program example 4-23
DOP Mode 3-10

Downloading a configuration 2-31

E

Edit permissions 3—14, 3-21, 3-31



F K

Factory default parameters 3—32 Keypad

Frequency Setting source 3—30 key grouping 3-2
Frequently asked questions 1-8 orientation 1-4
Full duplex 4-2 standard 2-5

Keypad bay 2-5
Keypad control 3—4

G

Gasket seal 2-9 Kit components 1-7

H L
Half duplex 4-2
Hand/Auto key 3-30

Help screen

LED indicators 1-5, 5-7

Loopback connector 5-6

accessing 3-3 M
configuration 2-30 Manual/automatic selection 3—2
Metasys N2 2—-19, 4-2
I ModBus

Initialization 3—18, 3-32 host program example 418

ModBus ASCII 2-19, 4-2

ModBus RTU 2-19, 4-2

Modular RJ45 connector 2—15

Monitor Mode 3-3, 3-27
configuring Monitor Vars 3-29

Inverter
EEPROM 3-13, 3-17
firmware 3—17
powerup 3—18
RAM 3-13, 3-17
variables 3-27
Inverter port 2—4

edit permissions 3-31
Hand/Auto key 3-30
Inverter type configuration 2—24 Motor control

example procedure 3—8

keys 3-2




Mounting 1-2

Mounting options 22
Mounting to DIN rail 2—12

Mounting to inverter 2—5

Mounting to panel 2—8
Mounting, O-ring 2—-10, 2—12

N

Network control 3—4
Network port 2—4, 4-2

configuration 2-26

Network Register Map

SJ100/L100 inverters E-2
SJ300 / L300P inverters D-2

Network setup 4-2

Network termination 4—8

Network termination board 4-9

installation 4-9

Normal operation modes 3-3

(0

O-ring 2-10, 212
Output frequency 3-28

P

Parameter editing 3-2, 3—18

PC

COM port selection 2—-33
connecting to 2—-18
downloading a configuration 2—-31

uploading a configuration 2-21

Power supply, SC-OPE 2-17
Powerup of inverter 3—18
Program Menu List

J300 inverters C-2

SJ100 / L100 inverters B-2

SJ300 / L300P inverters A—2
Program Mode 3-3, 3-11

edit permissions 3—14

example 3—12

Q
Quick Menu 3-3, 3-19
configuring 2-29, 3-22
edit permissions 3-21
Read/Write menu 3-25
standard items 3-22

R

Read EEPROM data 3-18, 3—-19
RJ45 connector 2—15
RS-232 port 2-18

wiring diagram 4-3, 54
RS-422/485 port

wiring diagram 4-5
Run command source 3-30
Run direction restriction 4—15
Run FWD command 3-9




S Software Lock Mode 3-14, 3-21, 3-31

SC-OPE Special Modes 3-10

Configuration Editor 2-19 Specifications 1-6

control method 3—4 Start Run key 3-9

diagnostics 5-6 Startup screen

dimensions 2—8 configuration 2—30

EEPROM 3-17 Stop/Reset key 3-9

features 1-2 Store to EEPROM 3-18, 3-19, 3-20

firmware 3—17 T

keypad 3-2

. Termination resistors 4-8, 5—6
mode selection 3-2 )
) ) Troubleshooting 5-2
mounting options 22
mounting to DIN rail 2—12 VvV
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